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Why LapLink?

LapLink gives you the freedom to leave the office without giving up access to your office com
network resources. Whether you’re traveling on business or working from home, you can still r
mail, share the latest files with coworkers, access network programs and databases, browse t
over a high-speed connection, and collaborate with colleagues. Things you once could do onl
office you can now do remotely.

Suppose you work at home
Instead of joining the morning rush-hour traffic, you sit down 
at your home computer, connect to your office, and begin 
your workday as usual, by tackling your e-mail.

While finishing your orange juice, you read your messages, 
write new ones, send replies—in other words, you operate 
much as you would in the office. You’re using LapLink. In 
particular, you’re using Remote Control, one of the LapLink 
services, to operate your office computer from home.

On your home monitor you see what you would have seen 
had you commuted to work, and you operate your e-mail 
program as you would have from the office. You can even 
use your home printer for those messages you’ll review 
later.

Forget to get the latest copy of a file before leaving the 
office? Move to File Transfer, another LapLink service, and 
drag the file from the folder on the office network to its loca-
tion on your hard drive at home. Since you’re updating a file 
already on your home computer, the file is transferred 
almost before you know it. (In fact, LapLink merely updates 
the file, transferring only the parts that have changed.)

Returning to Remote Control, you start a network applica-
tion and access the company’s huge product database. 
Just as you thought, customers ordered more blue widgets 
last month than during the previous two months combined! 
More grist for the quarterly report you’re working on.

While you’re still connected, you chec
competition really selling their widgets
Connecting over the dedicated Interne
visit the competition’s Web site. Whew
all!

A final check of your e-mail confirms y
to Chicago tomorrow for a two-day bu

Suppose you’re on a business tr
Settling into your hotel room, you take
long enough to discover a dedicated 
the better to connect to your office co
the local number for your Internet ser
by opening a LapLink connection ove

It’s been a busy day. You need to catc
coworkers and exchange the latest fil
rush through your e-mail, finishing in 
coworker’s computer. Her e-mail soun
you’re free before 7 o’clock this evenin
the cover art for the annual report?

Now you’re looking at her monitor an
same time, using another LapLink ser
some discussion and trying this and t
agree: make the logo larger and reve
have a finished draft waiting for you o
hour.
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In an hour, however, you expect to be at your favorite Chi-
cago restaurant, choosing from the dessert menu. On your 

By the time you return to your hotel room, LapLink will have 
exchanged the quarterly report you finished on the red-eye 

await your review on 
atest draft of the cover 
iew all of this.
way out the door, you schedule LapLink to reopen the con-
nection with the office and synchronize folders on your lap-
top with folders on the office network.

flight this morning for the reports that 
the office network. And you’ll get the l
art as well. Now to find the time to rev
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Staying in touch with the office

Phone lines, modems, and LapLink: these are the basics necessary to connect to the office f
or elsewhere. To these basics you can add a network, a network server, even the Internet. You
how to connect by considering your office setup and what you want to accomplish when you a
connected.

Connecting to the office requires that your home computer 
or your laptop have a modem and a phone line to connect 
to. It must also be running LapLink.

Depending on the availability of a network and the Internet 
in your office, you can then make any or all of these kinds of 
connections:

• To your office computer directly

• To your office computer or another office computer 
through the office network

• To your office computer through the Internet

Connecting directly to your office computer
If your office computer is equipped with a modem, you can 
connect to the computer directly, using Connect over 
Modem.

Turn on the modem and leave LapLink running when you 
leave the office. Then connect through the modem and run 
programs and transfer files as you would normally.

If your computer is attached to a network, you can read your 
e-mail and access the customary network resources, 
though you cannot connect to other computers on the net-
work.

Connecting to the office network
If your office has a network, you can c
and then to any computer running La
including your own. In fact, you can a
resources normally available to you fr
browse the Internet from your desk at
you can browse it from afar, too.

LapLink gives you two ways to conne
work:

• Dial in to a dedicated network dia
up Networking

• Dial in to a modem on an office co
Net

Before using LinkToNet, set up your c
computer as a LinkToNet host. When
leave LapLink running, with the mode

Connecting over the Internet
Many workstations now have direct In
dedicated, high-speed connections. If
is one of these—and you have Intern
home computer or your laptop—you 
office using Connect over Internet.
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Using Connect over Internet is like connecting to your office 
computer by modem, with these advantages:

• If you connect to the Internet over a high-speed line 
while you’re away from the office, you can improve the 

ffice.

et up your office com-
g its address through 
e sure to leave 
• The office computer does not require a modem.

• If you make a local call to connect to the Internet while 
you’re away from the office, you can save money on 
your long-distance connections to the office.

speed of your connection to the o

Before connecting over the Internet, s
puter for Internet access by publishin
the LapLink Internet directory. Then b
LapLink running.
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Connecting at the office

With greater resources at hand, you can make faster connections—and connect in more wa
working in the office. Connect over a corporate network, for example, for the fastest file transfe
LapLink cable to synchronize your desktop and laptop before and after you travel. And take ad
your organization’s direct connection to the Internet for cheap connections to distant locations

Connect to other computers on your network
If your office is equipped with a local network (LAN), you 
can connect directly to any other network computer running 
LapLink using Connect over Network.Because LapLink 
connections over networks are fast, they are ideal for send-
ing large amounts of data in a short time.

Suppose it’s your job to distribute files to several computers 
every Tuesday. To automate the operation, create an 
Xchange Agent file by showing LapLink which files to copy 
and where to copy them. When Tuesday arrives, run the 
Xchange Agent yourself or schedule it to run unattended, at 
a time when the computers are usually idle. LapLink auto-
matically connects to the computers, transfers files to the 
designated folders, and disconnects, all without assistance.

It may also be your job to maintain those computers. With-
out leaving your desk, you can use Remote Control to trou-
bleshoot problems on other computers, chatting with their 
users, if necessary.

Connect your laptop to your desktop
If you take your laptop—and your work—with you when you 
leave the office, you know the routine: update files on your 
laptop before you leave; update files on your desktop when 
you return.

To update files on either computer, attach a LapLink cable 
and run LapLink on both computers. A connection opens 
automatically.

You could then locate the most recen
laptop or the desktop, and copy them 
Instead, you create an Xchange Agen
ation automatically. You also set up L
agent whenever you start LapLink.

In the future, simply attach the cable a
both computers. Your files will be upd

Connect to distant computers ov
Does your office have a direct line to 
online and use Connect over Internet
LapLink computers on the Internet an
By combining LapLink and the Interne
computers anywhere in the world.

Before you use Connect over Interne
will set up LapLink on their computers
addresses, or other unique identifiers
through an Internet directory as their 
They then notify you of their new add

Once you go online and run LapLink,
puter’s Internet address to locate the 
connection.

1 Some computers have IP addresses th
you connect to one of these computer
working and supply that computer’s IP
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How can I connect to other computers?

Determine how to connect to another computer from the resources available to the two com
example, are both logged on to the same office network? Then connect over the network. Do
Internet access? Then connect over the Internet. Use the tables in this section to help decide 
connect. No matter how you connect, you can always use File Transfer, Remote Control, and
LapLink services.

Connecting over the Internet

Can you connect to the Internet on 
the local computer?

Then connect to another LapLink computer
over the Internet this way:

Yes
Connect to the Internet as usual and then use Connect over Intern
LapLink.

No, but the office has a direct connec-
tion to the Internet

•  Set up an office computer as a LinkToNet host. Use Connect ove
ToNet to dial in to the network through the host and connect over the
Internet connection.

•  Or use Connect over Dial-Up Networking to dial in to a network 
and connect over the office Internet connection.
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Connecting over modems, networks, cables, or wireless devices

For details 
see

mputer.
page 16

r LinkTo-
ink com-

uter and 

page 18

page 16

 and con-
page 20

page 30

on opens 

nections 
page 34

 over 

. You can 
page 34

in range 

e.
page 36
What resources are
available for connections

Then connect to another LapLink computer this way:
on the local 
computer?

on the remote 
computer?

modem modem
Use Connect over Modem and dial in to the modem on the remote co

Modem connections are available in all versions of Windows.

modem
modem and net-
work

•  Set up the remote computer as a LinkToNet host. Use Connect ove
Net to dial in to the modem on that computer and connect to any LapL
puter on the network.

•  Or use Connect over Modem to connect directly to the remote comp
access all of the network resources available to that computer.

modem
network with a 
dial-up server

Use Connect over Dial-Up Networking to dial in to the dial-up server
nect to any LapLink computer on the network.

network network
Use Connect over Network.

Network connections are available in all versions of Windows.

parallel or serial 
port

parallel or serial 
port

Attach a LapLink parallel or serial cable to each computer. The connecti
automatically.

Serial connections are available in all versions of Windows. Parallel con
are available in Windows 95/98 and Windows Me.

USB port USB port

Attach a LapLink USB Network cable to each computer. Use Connect
USB Network. 

USB Network connections are available in Windows 98, 2000, and Me
use the older LapLink USB cables with Windows 95/98.

wireless device wireless device
The connection opens automatically as soon as the devices come with
of each other.

Wireless connections are available in Windows 95/98 and Windows M
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Connecting by modem—Overview

Using modems and a phone line, you can connect to another computer or to an office netw
direct, LapLink to LapLink connection, dial a modem on another computer using Connect ove
For a connection to an office network—and then to any LapLink computer on the network—us
LinkToNet to dial a modem on a computer set up as a LinkToNet host or Dial-Up Networking t
dedicated dial-up server (RAS). 

Connecting directly to another computer
You can connect any two computers by modem if LapLink is 
running on both computers and a modem and a phone line 
are attached to each.

When you dial directly to another LapLink computer, you 
have access to all the programs and files available to that 
computer (including any network resources if the computer 
is logged on to a network).

Using Remote Control, for example, you can efficiently run 
large programs on the remote computer and access large 
files (including multiuser files such as order-entry systems 
or accounting systems).

Connecting through a network
Imagine using phone lines to extend the office network to 
your home or hotel room. That’s what you accomplish when 
you use modems to dial in to your office network.

Once on the network, you can connect to another LapLink 
computer and use LapLink services—Remote Control, File 

Transfer, and so on—just as you wou
to-modem connection.

But there’s more. When you dial in to
also:

• Connect to any LapLink compute
just one. (You can even transfer fi
puter to another.)

• Access all the network resources 
office. If you normally browse the 
work, for example, you can do the
remote location, using the browse
puter.

• Enhance security by combining L
tection with network security.

There are two ways to dial in to your 

Use LinkToNet  For a LinkToNet co
computer that’s connected to a TCP/I
equipped with a modem. This can be 
to connect to or any other network co
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After setting up this computer as a LinkToNet host, use Link-
ToNet to dial in and access the network and any LapLink 

have a dial-up server. (If in doubt about your network, ask 
the network administrator.)

 to the network 
 Dial-Up Networking 
computers on the network.

Use Dial-Up Networking  For a Dial-Up Networking con-
nection, your office network (either TCP/IP or IPX) must 

Using Dial-Up Networking, you dial in
through this server. (You can also use
to dial in to a LinkToNet host.)
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For a direct, LapLink to LapLink connection, dial a modem on another computer running Lap
open the connection, click the Connect button on the LinkBar and click Modem. Then choose
entries for modem connections you have entered in Address Book, or type a phone number d

Before you use Connect over Modem
• The LapLink security setup of the computer you are 

connecting to must be changed to allow incoming con-
nections. See page 46.

• LapLink must be running on both 

• Modem ports must be enabled in 
puters.

Use Connect over M
to dial a modem on 
another computer an
open a LapLink conn
to that computer.

Entries you have cre
for modem connectio
Address Book appea
the connection list to
connecting easier.
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Dialing from an Address Book entry Dialing manually
icated by such consid-
, and country codes, 
ut creating an 

Link dials the number 
ow you have set up 

nkBar, and then click 

umber to dial.

nsitive (i and I, for 
connections to other 
e passwords exactly 
rs, using capital letters 

k Tech, or LapLink 
e. For connections to 
ersions, type pass-
.

sswords in your 
omputers? See page 
Before dialing a computer, it’s a good idea to create an 
Address Book entry for that connection. Use the entry to 
store the phone number, requests for services (such as File 
Transfer and Remote Control), password, and other perti-
nent information.

When you use Connect over Modem, you see the Address 
Book entries you created for modem connections. When 
you use an entry to dial a connection, information stored in 
the entry is passed on to the remote computer for you. For 
details about using Address Book for modem connections, 
see page 22.

To connect to another computer by modem:
1 Click the Connect button on the LinkBar, and then click 

Modem.

2 In the Connections list, click the connection you want to 
open.

The connections listed under Manual Dial are your 
Address Book entries for modem connections. To create 
a new entry, click Address Book.

3 In the Dialing Location list, click the location you’re dialing 
from.

4 Under Services, check services you want to use.

5 Click the Dial button.

To dial a connection that is not compl
erations as calling cards, outside lines
you can type the phone number witho
Address Book entry beforehand. Lap
exactly as you type it, regardless of h
Dialing Properties.

To dial manually:
1 Click the Connect button on the Li

Modem.

2 Click Manual Dial.

3 In the Phone Number box, type the n

4 Click the Dial button.

Entering passwords
LapLink Gold passwords are case-se
example, are treated differently). For 
computers running LapLink Gold, typ
as they were typed on those compute
and lowercase letters as necessary.

• Passwords in LapLink Pro, LapLin
7.5 or earlier are not case-sensitiv
computers running any of these v
words in ALL CAPITAL LETTERS

• Are you having trouble getting pa
Address Book accepted by other c
23.
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connect to 
office. The 
led, and it 

y supplying its Win-

ature, must be 
l from. See Windows 

bled as a LinkToNet 
g connections.

Set up a modem-
equipped computer 
as your own dial-up 
server.

Then use LinkToNet 
to dial in to the net-
work through that 
computer and con-
nect to other 
LapLink computers 
on the network.
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Use LinkToNet to dial in to a computer and log on to a network from outside the office. Then 
other LapLink computers on the network and use network resources as if you were still in the 
computer you dial in to must be connected to a TCP/IP network, it must have a modem instal
must be enabled as a LinkToNet host.

Use LinkToNet to take the network with you when you leave 
the office. By dialing in to a LinkToNet computer on the net-
work, you can:

• Connect to any computers running LapLink on that net-
work.

• Connect to LapLink computers on the Internet. See 
page 28.

• Browse the Internet using the Internet connection avail-
able in the office. See page 28.

• Find a computer on the network b
dows computer name.

Before you use LinkToNet
• Dial-Up Networking, a Windows fe

installed on the computer you dia
help for instructions.

• A network computer must be ena
host so that it can receive incomin
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• The LapLink security setup of the LinkToNet host must 
be changed to allow LinkToNet connections. See page 

The first time you use LinkToNet, a helper guides you 
through the process of specifying your LinkToNet host. 

mber to dial.)

 and password1 
t host.

 computer.

box, click the name of 
.

e TCP/IP Addresses 
:

ame of the computer 

type the IP address of 

se are checked.

 for your LinkToNet 
nd then click Dial-Up 
, click your LinkToNet 
ties button.

ters and lowercase 

 are those you have 
n about creating 
orking connections, 

 see page 31.
54.

• The modem ports must be enabled in LapLink on both 
computers. See page 135.

• LapLink must be running on both computers.

NOTE LinkToNet and Dial-Up Networking both give dial-
up access to a TCP/IP network from outside the office. 
Use Dial-Up Networking to dial in to a network server 
(RAS); use LinkToNet to dial in to a LinkToNet host.

Enabling a network computer as a LinkToNet host
You can enable a computer as a LinkToNet host during 
setup or afterward.

To enable a network computer as a LinkToNet host 
after setup:
1 On the Options menu, click LinkToNet Options.

2 On the Host tab, check the Enable LinkToNet box.

3 If you are assured of a good phone connection, speed up 
your LinkToNet connections by checking the Use Compres-
sion When Sending Data box. Clear the box if you experi-
ence problems.

4 Click OK.

Connecting to a computer using LinkToNet

To connect to a network computer using LinkToNet:
1 Click the Connect button on the LinkBar, point to Link-

ToNet, and then click A LapLink Computer on the Net-
work.

(You need to provide the phone nu

2 When prompted, type the user name
required by LapLink on the LinkToNe

You can now connect to a network

3 In the Connect over Network dialog 
the computer you want to connect to

If the computer is not listed, click th
tab. Then do either of the following

• In the Connections list, click the n
you want to connect to.2

• Under TCP/IP Name or Address, 
the computer.3

4 Verify that the services you want to u

5 Click OK.

NOTE To change the phone number
computer, click the Connect button a
Networking. In the list of connections
connection and then click the Proper

1 For information about typing capital let
letters in passwords, see page 23.

2 The computers in the Connections list
placed in Address Book. For informatio
Address Book entries for Dial-Up Netw
see page 22.

3 For help in determining an IP address,



Dialing in to a network through a network server: Dial-Up Networking

tside the 
s if you 

ing
ature, must be 

l from. See Windows 

ted dial-up server 
t, Windows Remote 
m) or a computer The 
 connected to an IPX 

o 

. 
 

20

Use Dial-Up Networking to dial in to a dial-up server (RAS) and log on to a network from ou
office. Then connect to other LapLink computers on the network and use network resources a
were still in the office.

Use Dial-Up Networking to access a network after you leave 
the office. By dialing in to a dial-up server (RAS) on the net-
work, you can connect to any computer running LapLink on 
that network.

You can also connect to LapLink computers on the Internet 
and browse the Internet using the Internet connection in the 
office. In short, you can access the same network resources 
you use in the office.

Before you use Dial-Up Network
• Dial-Up Networking, a Windows fe

installed on the computer you dia
help for instructions.

• Your network must have a dedica
(such as Novell NetWare Connec
Access Server, or Shiva NetMode
computer you connect to must be

Use Dial-Up Networking t
dial in to a dial-up server 
and connect to a network
Then open connections to
other LapLink computers 
on the network.
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or TCP/IP network. It must also be running LapLink, 
and its security setup must have been altered to allow 

3 Ensure that this box is checked: After Dialing, Connect to a 
Computer on a Network.

 and password1 

box, click the name of 
.

 are attempting to 
ck the TCP/IP 
e following:

ame of the computer 

type the IP address of 

es you want to use are 

ters and lowercase 

 are those you have 
n about creating 
orking connections, 

P address, see 
incoming LapLink connections. See page 46.

Setting up a Dial-Up Networking connection
Before using Dial-Up Networking, create a Dial-Up Net-
working connection to the network server by supplying the 
number to dial.

NOTE Dial-Up Networking and LinkToNet both give dial-
up access to a network from outside the office. With Link-
ToNet, however, you dial in to a computer enabled as a 
LinkToNet host.

To create a Dial-Up Networking connection:

1 Click the Connect button on the LinkBar and then click 
Dial-Up Networking.

2 Click the New Connection button and follow the instructions 
on your screen.

Connecting to a network computer using Dial-Up 
Networking
To use Dial-Up Networking to connect to a network 
computer:

1 Click the Connect button on the LinkBar and then click 
Dial-Up Networking.

2 In the list of connections, click the connection to your net-
work server.

4 Click the Dial button.

5 When prompted, type the user name
required by the dial-up server.

6 In the Connect over Network dialog 
the computer you want to connect to

If the computer is not listed and you
connect over a TCP/IP network, cli
Addresses tab. Then do either of th

•In the Connections list, click the n
you want to connect to.2

•Under TCP/IP Name or Address, 
the computer.3

7 Under Services, verify that the servic
checked.

8 Click OK.

1 For information about typing capital let
letters in passwords, see page 23.

2 The computers in the Connections list
placed in Address Book. For informatio
Address Book entries for Dial-Up Netw
see page 22.

3 For information about determining an I
page 31.
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Making entries in Address Book simplifies the process of opening the same direct modem co
time after time. In your entries you store phone numbers, requests for services (such as File Tr
Remote Control), and passwords. When you use Connect over Modem, this information is pa
the remote computer for you. You can also set up entries for connections you make to network 
after you dial in to a network using LinkToNet or Dial-Up Networking.

Address Book is a convenient way of storing all the informa-
tion you need to connect to another computer using Con-
nect over Modem.

Address Book works in tandem with Dialing Properties, the 
Windows feature that lets you determine how your numbers 
are dialed. Use Dialing Properties to charge a call to a call-
ing card, for example, reach an outside line, or place long-
distance and international calls. For more information about 
Dialing Properties, see Windows help.

To create an Address Book entry fo
Modem connection:

1 Click the Address Book button on
click the Add button.

2 In the Description box, type a brief de
computer for your own reference.

3 In the Computer Name box, type the
assigned to the remote computer.

For modem connections 
you make again and again, 
simplify the connecting 
process by adding entries 
to Address Book.

Then access the informa-
tion you store in these 
entries when you use Con-
nect over Modem, LinkTo-
Net, or Dial-Up 
Networking.
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4 In the Connection Type list, click Modem. Using Address Book for dial-up connections to 
network computers

fter dialing in to a net-
 store requests for ser-
formation is passed to 
ct to a network using 

k: Available Now if the 
 of available comput-
ork in the office. Oth-

s and type the 
 a computer’s IP 

nsitive (i and I, for 
connections to other 
e passwords in capital 
ere typed on those 

pLink Tech, or 
ensitive. In Address 
f these versions, type 
S. If you have old 
ctions, retype their 

e sensitivity, Address 
pLink version may no 
that have also been 
up on those comput-
 entries to match.
5 Under Phone Number, type the area code and phone num-
ber, and click the country code.

TIP If you want to have a phone number dialed exactly as 
you type it in the Telephone Number box, clear this box: 
Use Country Code and Area Code.

TIP Requests for services in Address Book are honored 
only if the security setup of the remote computer permits

6 Under Services, check the services you want to use.

TIP You can change your selections later, as part of the 
connection process. You can also request new services 
after you connect.

7 Under Host Locking on Connect, check the kind of locking 
you want to take effect on the remote computer when you 
connect for Remote Control.

You can lock a host (blank its screen or disable its mouse 
or keyboard) only if it has been configured to allow lock-
ing.

8 Under Security Information to Send, type the log-in name 
and the password you must provide in order to gain access 
to the remote computer. Reenter the password to confirm.

When you finish the entry, you see Address Book and the 
description of the new entry. If you want to create another 
entry, click Add again and complete the entry. Otherwise, 
click Close.

For LapLink connections you make a
work, set up Address Book entries to
vices and security information. This in
the network computer after you conne
LinkToNet or Dial-Up Networking.

As the Connection Type, use Networ
computer normally appears in the list
ers when you use Connect over Netw
erwise, use Network: TCP/IP Addres
computer’s IP address. To determine
address, see page 31.

Entering passwords
LapLink Gold passwords are case-se
example, are treated differently). For 
computers running LapLink Gold, typ
or lowercase letters exactly as they w
computers.

NOTE Passwords in LapLink Pro, La
LapLink 7.5 or earlier are not case-s
Book entries for connections to any o
passwords in ALL CAPITAL LETTER
Address Book entries for such conne
passwords in all capital letters.

NOTE Because of the change in cas
Book entries created in an earlier La
longer let you connect to computers 
upgraded: have new passwords set 
ers; then change your Address Book
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Connecting over the Internet

Connect to the Internet, and you can open connections to other LapLink computers anywhe
world, without spending a fortune. To make a computer easy to find on the Internet, use the La
Internet directory to “publish” the computer’s Internet address. Other computers can then supp
address to open connections using Connect over Internet.

When connected to another LapLink computer on the Inter-
net, you can use Remote Control, File Transfer, and any of 
the other LapLink services you would use when connected 
directly by modem—often at reduced cost. For the easiest 

Internet connections, use Connect ov
the Internet address the remote comp
through an Internet directory like the o
LapLink.com.

Go online and use 
nect over Internet to
and open connectio
LapLink computers
where on the Intern

Make a connection
plying the address 
lished by a remote 
computer through t
LapLink Internet dir
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Before you use Connect over Internet one the remote computer has published through an Inter-
net directory).

you want to use.

 connections
sing Connect over 
k entries to store Inter-
 and security informa-
work computer when 

try for the Internet, be 
tion Type box.

sing Connect over 

k for connections on a 
 it for connections on 
etworks.

, you must supply the 
s published through 

 when you connect to 
r change. For more 
r Network, see page 
• Both computers must be connected to the Internet.1

• The remote computer (the one you are connecting to) 
must have its Internet address published through an 
Internet directory. See page 26.

• The security setup of the remote computer must have 
been configured to allow incoming connections. See 
page 46.

• The TCP/IP ports must be enabled in LapLink on both 
computers. See page 142.

• LapLink must be running on both computers.

Using Connect over Internet
To connect to another LapLink computer on the Inter-
net:

1 Connect to the Internet as usual.

2 Click the Connect button on the LinkBar, and then click Inter-
net.

3 If you have created an Address Book entry for the connec-
tion you want to open, click the connection in the Connec-
tions list.

Otherwise, click Manual Connect. In the Internet Address 
box type the remote computer’s Internet address (the 

4 Under Services, check the services 

5 Click OK.

Using Address Book for Internet
For LapLink connections you make u
Internet, you can set up Address Boo
net addresses, requests for services,
tion. All of this is passed on to the net
you use Connect over Internet.

When you create an Address Book en
sure to specify Internet in the Connec

Opening Internet connections u
Network
Just as you use Connect over Networ
local TCP/IP network, so you can use
the Internet, a global web of TCP/IP n

When you use Connect over Network
computer’s IP address, not an addres
an Internet directory.

Connect over Network is most useful
computers whose IP addresses neve
information about using Connect ove
30.1 If you are out of the office and without access to the Inter-

net, dial back to the office network and use the office Inter-
net connection. See page 28.
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Internet connections, like e-mail messages, need addresses. To make your computer availab
LapLink computers on the Internet, publish its address through an Internet directory. LapLink u
know this address can then locate your computer on the Internet and open connections from a
the world. As a free service to our users, LapLink.com maintains the LapLink directory to promo
connections between computers running LapLink.

Connecting to computers on the Internet is easy—when 
you know their IP addresses. But IP addresses can be hard 
to determine, and they often change. If you dial in to an 
Internet service provider, for example, your computer usu-

ally is assigned a different IP address
online.

So how do you make your computer 
LapLink computers on the Internet? Y
address (or other unique identifier) “pu

To allow other LapLink c
connect to a computer o
net, set up LapLink to ha
puter’s address publishe
LapLink Internet director

In Internet Directory Opt
an e-mail address or som
unique identifier as the I
address.

Then notify other LapLin
that they can connect by
the Internet address you
fied.
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Use LapLink to specify the address to be published and 
when it will be published—for example, whenever you are 

• To publish the address yourself, without a confirma-
tion dialog box, clear this box: When Manually Pub-

firmation.

ddress for you, check 
 My Address When 

our computer’s 
ctory Server: 

puter’s Internet 
curity setup before 
e Internet. For more 

s
r address automati-
e Internet (step 3, 
.

urself:

 My Internet Address.
using LapLink on the Internet.

Use the LapLink Internet directory to publish your address; 
the directory is available without cost to LapLink users, and 
you don’t have to sign up to use it.

NOTE Publishing your Internet address does not open 
your computer to unwanted connections. LapLink users 
who know your published address can connect; others 
cannot, even if they are using NetMeeting or other pro-
grams that rely on Internet directories.

To set up LapLink to have your computer’s address 
published on the Internet:

1 On the Options menu, click Internet Directory Options.

2 In the Internet Address box, type your e-mail address or 
another unique identifier.

This will be your Internet address. Give it (as well as log-
in name and password) to any LapLink user you allow to 
connect to your computer on the Internet.

3 Set options to determine how to publish your Internet 
address:

lishing My Address, Show Con

• To have LapLink publish your a
this box: Automatically Publish
I’m Connected.

4 Set the Internet directory to publish y
address like this: Use a LapLink Dire
ils.laplink.com

5 Click OK.

TIP In addition to publishing a com
address, you must also change its se
other computers can connect over th
information, see page 46.

Publishing your Internet addres
You can set up LapLink to publish you
cally whenever you run LapLink on th
above). Or you can publish it yourself

To publish your Internet address yo

1 Connect to the Internet as usual.

2 On the Connect menu, click Publish
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If you have no Internet access once you leave the office, dial in to the office network remotely
connect to the Internet as you would in the office. You can then connect to LapLink computers
on the Internet or surf the Web. 

You may be used to going online regularly in the office, over 
a direct connection to the Internet. But have you considered 
tapping this resource from outside the office as well?

Through LapLink you can dial in to the office network and 
use its direct Internet line from home or elsewhere. A 
LapLink connection lets you connect to other LapLink com-
puters on the Internet, check on your favorite Web sites, 
chat with colleagues and family—in short, use the Internet 
as you might back in the office.

You might connect to the office solely for the Internet. Or 
you might read your e-mail, synchronize files, and use the 
Internet all in the same connection.

Just as you connect to the network before using the Internet 
in the office, so you must connect to the network before 
accessing the Internet remotely. LapLink offers two ways to 
connect to an office network from outside the office:

• Use LinkToNet to dial in to a modem attached to one of 
the computers on the network.

• Use Dial-Up Networking to dial in to a network dial-up 
server.

It makes little difference which you do
net connections and browse the Web
or Dial-Up Networking. A Connect ov
lets you open Internet connections. T
the computer you are dialing in from l
the Web.

Using LinkToNet  To prepare an of
you can dial in to it, use LapLink to en
host.

To prepare the computer you will be d
phone number of the office computer

Then use LinkToNet and specify wha
you first connect: link to another LapL
Internet or browse the Web.

For more information about using Lin

Using Dial-Up Networking  Use D
supply the phone number of the dial-u

If you specify that you want to make a
after you connect, a Connect over Ne
you enter the computer’s Internet add
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To browse the Internet after connecting, start your browser 
yourself.

For more information about connecting over the Internet, 
see page 24.
For more information about using Dial-Up Networking, see 
page 20.
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Connecting over an office network

Connect to any other computer running LapLink on your office network (LAN) and use Remo
File Transfer, or another LapLink service. Use Connect over Network and click the name of the
you want to connect to or supply its network address.

You can open a LapLink connection to another computer on 
your office network, whether it is an IPX (Novell NetWare) 
network or a TCP/IP network.

NOTE To simplify routine connections over a network, create 
Address Book entries. See page 32.

You can often open a network connec
the computer’s name in a list of LapL
network. To open a connection to a c
side your portion (subnet) on a TCP/I
you must provide the computer’s TCP
no list to choose from.)

Use Connect over
to link computers o
office network.

You can click the n
computer or switch
TCP/IP Addresses
type the computer
address.
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Before you use Connect over Network 3 Under Services, check the services you want to use, such 
as File Transfer and Remote Control.

dress in Windows 95 

etup.

t, and then click the 

IP Address box.

dress in Windows 

int to Programs, and 

.

uter appears in the IP 

work computers
lar computer in the 
typing all or part of the 
x; then click Refresh 

omputers again, click 
 Filter box, click All 

st.
• The security setup of the remote computer (the one you 
are connecting to) must be configured to allow incom-
ing connections. See page 46.

• The network ports (either TCP/IP or IPX) must be 
enabled in LapLink on both computers. See page 140.

• LapLink must be running on both computers.

NOTE Not only does Connect over Network work over 
local networks, it also connects over the Internet. For 
details see page 25.

To connect to another computer by network:

1 Click the Connect button on the LinkBar, and then click 
Network.

2 In the Connect over Network dialog box, click the name of 
the computer you want to connect to.

If the computer is not listed and you are attempting to 
connect over a TCP/IP network, click the TCP/IP 
Addresses tab. Then do either of the following:

• In the Connections list, click the name of the com-
puter you want to connect to.1

• Under TCP/IP Name or Address, type the IP address 
of the computer.

4 Click OK.

Finding a TCP/IP address
To find out a computer’s TCP/IP ad
or Windows 98:

1 On the Options menu, click Port S

2 Click TCP/IP Network in the Ports lis
Configure button.

3 The TCP/IP address appears in the 

To find out a computer’s TCP/IP ad
NT:

1 Click the Windows Start button, po
click Command Prompt.

2 Type IPCONFIG and press ENTER

The TCP/IP address for that comp
Address line.

Filtering the list of available net
You can display the name of a particu
Connect over Network dialog box by 
name in the Computer Name Filter bo
List.

To display the names of all available c
the arrow next to the Computer Name
Computers, and then click Refresh Li

1 The computers in the Connections list are those you have 
placed in Address Book. For information about creating 
Address Book entries for Dial-Up Networking connections, 
see page 22.
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Simplify the process of opening connections by making Address Book entries for network co
you frequently connect to. In each entry you store the kind of network connection, the kinds of
(such as File Transfer and Remote Control) to be opened automatically, and the password. W
use Connect over Network, this information is passed on to the remote computer for you.

When you connect over a local network, you may be able to 
choose from a list of computers currently available on the 
network. If not, you type the computer’s network (TCP/IP) 
address. When you create an Address Book entry for a net-
work connection, you designate which of the two types of 
connections you are using:

• Network: Available Now For c
appear in the list of currently avail

• Network: TCP/IP Address For
require a TCP/IP address.

For network connections 
you make again and 
again, simplify the con-
necting process by adding 
entries to Address Book.

Then access the informa-
tion you store in these 
entries when you use Con-
nect over Network.
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To create an entry in Address Book for a network con-
nection:

8 Under Security Information to Send, type the log-in name 
and the password you must provide in order to gain access 

 password to confirm.

ou see Address Book 
y. If you want to create 
complete the entry. 

k, click the entry, and 
evision as a new 
click Delete.

nsitive (i and I, for 
ddress Book entries 
nning LapLink Gold, 
 typed on those com-
case letters as neces-

pLink Tech, or 
ensitive. For connec-
se earlier versions, 

TTERS. If you have 
nnections, retype 

e sensitivity, Address 
pLink version may no 
that have also 
up on those comput-
 entries to match ver-
1 Click the Address Book button on the LinkBar and then 
click the Add button.

2 In the Description box, type a brief description of the remote 
computer for reference.

3 In the Computer Name box, type the exact LapLink name 
assigned to the remote computer.

4 In the Connection Type list, click Network Available Now or 
Network TCP/IP Address.

5 If you selected Network TCP/IP Address, type the IP 
address of the remote computer under TCP/IP Address.

For help in determining a computer’s IP address, see 
page 31.

6 Under Services, check the services you want to open when 
you connect to the remote computer, such as File Transfer 
and Remote Control.

Your requests for services in Address Book will be hon-
ored only if the security setup of the remote computer 
permits.

7 Under Host Locking on Connect, check the kind of locking, if 
any, you want to take effect on the remote computer when 
you connect for Remote Control.

You can lock a host (that is, blank its screen or disable its 
mouse or keyboard) only if it has been set up to allow 
locking.

to the remote computer. Reenter the

When you have finished the entry, y
and the description of the new entr
another entry, click Add again and 
Otherwise, click Close.

TIP To edit an entry in Address Boo
then click Edit. To copy an entry for r
entry, click Copy. To delete an entry, 

Entering passwords
LapLink Gold passwords are case-se
example, are treated differently). In A
for connections to other computers ru
type passwords exactly as they were
puters, using capital letters and lower
sary.

NOTE Passwords in LapLink Pro, La
LapLink 7.5 or earlier are not case-s
tions to computers running any of the
type passwords in ALL CAPITAL LE
old Address Book entries for such co
their passwords in all capital letters.

NOTE Because of the change in cas
Book entries created in an earlier La
longer let you connect to computers 
upgraded: have new passwords set 
ers; then change your Address Book
sions.
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Connecting by cable

When you connect two computers by LapLink cable, attach the cable—serial, parallel, or U
Network—to both computers and start LapLink on both computers. Autoconnect, the default s
cable connections, opens a connection automatically. To manually connect, click the Connect
the LinkBar, and then click Cable.

Attach one end of 
the yellow LapLink 
parallel cable to a 
parallel port on 
each computer.

The blue LapLink serial cable 
has two connectors at one 
end, but only one connector is 
attached at a time: Use the 
larger connector if one of the 
computers has a 25-pin serial 
port. Otherwise, attach one of 
the smaller connectors to each 
computer.
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Choose the type of cable—serial, parallel, or USB (Univer-
sal Serial Bus)1 Network—you are going to use based on 

In addition, you can attach a USB cable to any USB periph-
eral that incorporates a “hub” to which other devices can be 

more than one USB-

r by serial or 

uters connected by 
. Autoconnect, the 
causes the computers 
e this setting, you can 
lly.

 automatically, click 
 verify that the appro-
abled for cable.

mputer by serial or 

nkBar, and then click 

 of the computer you 

you want to use, such 
l.

onnect Options on 
ab, clear the Enable 

 USB Network cable

nkBar, and then click 

ame of the computer 
k OK.
the cables and ports you have available.

Ports are the connectors to which you attach cables and 
peripherals like printers and external modems. To find out 
which types of ports are available, consult the documenta-
tion or the Windows Device Manager for your computer.

Once you decide which kind of cable connection you’ll use, 
plug a LapLink cable into both computers: attach a LapLink 
serial cable to a serial port on each computer, a LapLink 
parallel cable to a parallel port on each computer, or a 
LapLink USB Network cable to a USB port or a USB “hub” 
device on each computer.

Before you connect by cable
• Attach an end of a LapLink cable to each computer.

CAUTIONIf you are using the new LapLink USB network 
cable, you must install the USB Network cable driver 
before you attach the cable to your computer.

• Ensure that the proper port—serial, parallel, or USB—is 
enabled in LapLink on both computers. See page 144.

• Run LapLink on both computers.

Cables to use for LapLink connections
For a serial, parallel or USB Network connection use a 
LapLink cable, available from LapLink.com.

If there is more than one type of port available to you, 
remember that parallel cables transfer data faster than 
serial cables. And USB cables, the fastest of the three, 
transfer up to seven times faster than serial cables.

connected. This feature lets you use 
compatible device at a time.

Connecting to another compute
parallel cable
When you start LapLink on two comp
cable, they will automatically connect
default setting for cable connections, 
to connect automatically. If you chang
connect to the other computer manua

TIP If the connection does not open
Port Setup on the Options menu and
priate port (COM, LPT, or USB) is en

To manually connect to another co
parallel cable:

1 Click the Connect button on the Li
Cable.

2 In the Connection list, click the name
want to connect to.

3 Under Services, check the services 
as File Transfer and Remote Contro

4 Click OK. 

TIP To turn Autoconnect off, click C
the Options menu. On the Connect t
Autoconnect box.

To connect to another computer by

1 Click the Connect button on the Li
USB Network.

The Network dialog box appears.

2 On the Available Now tab, click the n
you want to connect to, and then clic

1 Not all connection types are supported in all Windows 
operating systems. See the table on page 13 for more 
information.
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Connecting by wireless

To connect to another computer using wireless devices, simply start LapLink, and the connec
automatically. Autoconnect, the default setting for wireless connections, lets computers conne
automatically when you run LapLink. To connect manually, click the Connect button on the Lin
then click Wireless.

Using LapLink, you can open short-range connections 
between computers equipped with infrared and other wire-
less devices.1

You can also connect using other wire
cellular modem, use Connect over M
LAN adapter, use Connect over Netw

C
w
c
p
r
d
r

1 Wireless connections are not available in Windows NT or 
Windows 2000.
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Before you connect by wireless 2 In the Connection list, click the name of the computer you 
want to connect to.

you want to use, such 
l.

onnect Options on 
ab, clear the Enable 

ink must first be set up 
indows infrared driver 

including fast infrared 
d to serial ports. If the 
r, you can download it 
.

river, specify any 
he redirected port. In 
enu) and enable the 
munications.
• Prepare your infrared or other wireless devices to com-
municate with each other.

• Ensure that the wireless port on each computer is 
enabled in LapLink. See page 146.

• Run LapLink on both computers.

Connecting to another computer by wireless
When you start LapLink on both computers, a connection 
opens automatically over their wireless devices. Autocon-
nect, the default setting for wireless connections, forces the 
computers to connect to each other. If you change this set-
ting, you can connect to the other computer manually.

TIP If the connection does not open automatically, click 
Port Setup on the Options menu and verify that the appro-
priate COM port is enabled for wireless communications.

To manually connect to another computer by wireless:

1 Click the Connect button on the LinkBar and then click 
Wireless.

3 Under Services, check the services 
as File Transfer and Remote Contro

4 Click OK. 

TIP To turn Autoconnect off, click C
the Options menu. On the Connect t
Autoconnect box.

Using infrared devices
The infrared devices you use in LapL
in Windows 95 or Windows 98. The W
supports a variety of built-in devices, 
devices, as well as adapters connecte
driver is not installed on your compute
from the Microsoft site on the Internet

TIP When you install the infrared d
COM port from COM1 to COM9 as t
LapLink, click Port Setup (Options m
same redirected port for wireless com
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Connecting over CAPI 2.0/ISDN

If CAPI 2.0/ISDN lines are available to your computer and the computer you are connecting 
both computers are set up for CAPI 2.0/ISDN communications—you can open a high-speed c
and use Remote Control, File Transfer, and other LapLink services. To connect, click the Conn
on the LinkBar, and then click CAPI 2.0/ISDN.

CAPI 2.0/ISDN is an implementation of ISDN, an interna-
tional communications standard for sending voice, video, 
and data over digital telephone lines, at faster rates than 
those possible using modems.

NOTE LapLink does not offer CAPI 2.0/ISDN as a means 
of connecting unless CAPI 2.0/ISDN is installed on your 
computer.

CAPI 2.0/ISDN is widely used in Euro
many. In North America ISDN seldom
CAPI 2.0, but you can still use your IS
speed LapLink connections: If you us
a modem, use Connect over Modem
it to dial in to, and log on to, a network
Network in LapLink.

Use Connect over 
ISDN to link compu
ever the CAPI 2.0 
ISDN is available.

Entries you have c
CAPI 2.0/ISDN con
in Address Book a
the connection list 
connecting easier.
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Before using Connect over CAPI 2.0/ISDN Dialing from an Address Book entry
idea to create an entry 
hough you do not dial 

choose among its 
 computer.

 for a CAPI 2.0/ISDN 

 the LinkBar and click 

scription of the remote 

 exact name assigned 

I 2.0/ISDN.

ne number.

you want to use when 
 (such as File Transfer 

ss Book will be hon-
 remote computer per-

 type the log-in name 
 in order to gain access 
 password to confirm.

s running LapLink 
ey were typed on the 
l letters and lower-

nning earlier versions 
CAPITAL LETTERS. If 
 for such connections, 
 letters.
• A CAPI 2.0/ISDN adapter and driver must be installed 
on both computers.

• Both computers must be running a version of LapLink 
that supports CAPI 2.0/ISDN.

• The security setup of the remote computer (the one you 
are connecting to) must be configured to allow incom-
ing connections. See page 46.

• CAPI 2.0/ISDN ports must be enabled in LapLink on 
both computers.

• LapLink must be running on both computers.

Connecting to a computer over CAPI 2.0/ISDN
To connect to a computer over CAPI 2.0/ISDN:

1 Click the Connect button on the LinkBar, and then click 
CAPI 2.0/ISDN.

2 Click the name of the computer you want to connect to in 
the Connection list or type a phone number under Dialing.

The connections listed under Manual Dial are your 
Address Book entries for CAPI connections. To create a 
new entry, click Address Book.

3 Under Services, check the services you want, such as File 
Transfer and Remote Control. You can choose any combi-
nation of these services.

4 Click the Dial button.

Before dialing a computer, it’s a good 
for that connection in Address Book. T
directly from Address Book, you can 
entries when you connect to a remote

To create an entry in Address Book
connection:

1 Click the Address Book button on
the Add button.

2 In the Description box, type a brief de
computer as a reference.

3 In the Computer Name box, type the
to the remote computer in LapLink.

4 In the Connection Type list, click CAP

5 Under Phone Number, type the pho

6 Under Services, check the services 
you connect to the remote computer
and Remote Control).

TIP Requests for services in Addre
ored only if the security setup of the
mits.

7 Under Security Information to Send,
and the password you must provide
to the remote computer. Reenter the

For connections to other computer
Gold, type passwords exactly as th
other computers; that is, use capita
case letters as necessary.

TIP For passwords to computers ru
of LapLink, type passwords in ALL 
you have old Address Book entries
retype their passwords in all capital



Changing CAPI 2.0/ISDN performance in LapLink

sponds to 
mple, you 

double the 

rt Setup, you can 
fy the way LapLink 
ments CAPI 2.0/
 connections.
40

Before using CAPI 2.0/ISDN in LapLink, you may want to customize the way that LapLink re
CAPI 2.0/ISDN calls and uses the two channels available for LapLink communications. For exa
can specify that LapLink not respond to any incoming calls to a particular channel, or you can 
rate at which data is transmitted over your CAPI 2.0/ISDN connections.

In Po
modi
imple
ISDN
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To change CAPI 2.0/ISDN performance in LapLink: TIP If you don’t want LapLink to answer any incoming 
calls, clear the Enable box under Auto Answer; then make 

e Following Numbers 

ept calls to, use only 
es, parentheses, 
re than one number, 

s that can be used for 
el has a transmission 

nding”) these chan-
, to 128 Kbps.

hannel bonding, even 
is setting keeps trans-
 who pay additional 

nel bonding. When 
can then transmit at 

ding on both comput-
e a connection 

n use, LapLink uses 
4 Kbps, even when 
1 On the Options menu, click Port Setup.

2 Under Port Settings, click CAPI.

3 Click the Configure button.

4 If you do not want LapLink to answer any incoming CAPI 
2.0/ISDN calls, clear the Enable box under Auto Answer.

To answer calls to only one number, type the number in 
this box: Accept Calls Only on the Following Numbers.

5 If you want to combine the two CAPI 2.0/ISDN channels for 
faster connections, check the Enable box under Channel 
Bonding.

Be sure that channel bonding is also enabled on the 
computer you will connect to.

6 Customize the Timeout options as necessary.

The Callback Timeout, Callback Delay, and Redial Delay 
settings are specified in seconds.

7 Click OK.

Answering calls
At the outset, LapLink is set up to answer all incoming CAPI 
2.0/ISDN calls on both channels. You can modify this so 
that it does not answer any of these calls or it answers calls 
to just one of the channels.

sure that the Accept Calls Only on th
box is blank.

TIP When typing the number to acc
numerals; avoid characters like dash
slants, and periods. When typing mo
use a semicolon to separate them.

Channel bonding
CAPI 2.0/ISDN provides two channel
LapLink communications. Each chann
speed of 64 Kbps. By combining (“bo
nels, the transmission rate can double

At the outset, LapLink does not use c
when both channels are available. Th
mission costs to a minimum for users
fees for each channel connection.

For faster transmissions, enable chan
both channels are available, LapLink 
speeds of up to 128 Kbps. 

TIP Be sure to enable channel bon
ers. LapLink may not be able to mak
between them otherwise.

TIP When one channel is already i
the available channel to transmit at 6
channel bonding is enabled.
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Connecting automatically

Once you have established a connection, you can save it for easy restoration later. You can
saved connection by double-clicking a shortcut icon, setting up LapLink to restore the connect
automatically when you start LapLink, or restoring the connection while running LapLink. Whe
restores a connection, it connects to the same computer or computers and opens the same s

Instead of spending time connecting to the same computer 
and opening the same services time after time, you can 
save the connection and use the saved connection as a 
convenient way to reconnect later.

NOTE To connect to several computers at once, open 
connections to those computers before saving connec-
tions.

When you save a connection, you rec
the number and types of connections
Internet, cable), the names of comput
services in use. Each connection is sa
the file reopens the connections and s
windows to appear much as they did 

You can res
tion three w

• Double-c

• Set up L
connecti
wheneve

• Restore 
self, whil
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Saving a connection 2 On the Startup tab, check this box: Restore Saved Connec-
tions at Startup.

 you want to open, or 

 of files, click the 
 and folder containing 

 extension. In Win-
 stored in the My Doc-
 are stored in the 
within the Windows 
dows NT logon 

ithout confirmation, 
p. Otherwise, click Ask 

running LapLink:

re Connections.

 you want to open, or 

 of files, locate the 
; then double-click the 
To save a connection:

1 Open one or more connections as usual.

2 On the Connect menu, click Save Connections.

3 In the File Name box, type a name to identify the connection 
file.

4 Click Save.

5 When asked whether you want a shortcut icon for this con-
nection on your Windows desktop, click Yes or No.

Restoring a saved connection
Once you have saved a connection, you can restore it three 
ways:

• If you created a shortcut icon on your Windows desk-
top, double-click the icon.

• Set up LapLink to restore the connection when you run 
LapLink again.

• Open the connection file while running LapLink.

NOTE To completely automate the connection process, 
create entries in Address Book for saved connections. 
Include the log-in name and password required to open 
each connection.

To set up LapLink to restore a saved connection when 
you start the program:

1 On the Options menu, click Connect Options.

3 Click the name of the connection file
type it in the Connection File box.

If the file does not appear in the list
Browse button and locate the drive
the file.

TIP Connection files have the .LLC
dows 95 and Windows 98, they are
uments folder. In Windows NT, they
\Profiles\yourname\Personal folder 
folder (where yourname is your Win
name).

4 If you want the connection restored w
click Automatically Connect at Startu
Before Connecting.

5 Click OK.

To open a saved connection while 

1 On the Connect menu, click Resto

2 Click the name of the connection file
type it in the File Name box.

If the file does not appear in the list
appropriate drive in the Look In box
folder containing the file.

3 Click Open.
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Allowing incoming connections

After you install LapLink, you can make outgoing connections to other computers, but other 
cannot open incoming connections to yours except by cable or wireless. To allow incoming co
change the security setup to Protected System and create one or more entries in the Log-in L
entry, specify the password and the log-in name the user must provide to open an incoming c
and grant the user permission to use services and other features.

The safest way to allow incoming connections is to set up 
password-protection by creating entries in the Log-in List. If 
you will be the only person to connect to this computer, 
make a single Log-in List entry and grant yourself whatever 

privileges you want. For other users, c
for each user or group of users accor
granted.

Click Log-in List 
Only (Protected 
System) and then 
click the Log-in List 
button.
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To set up password-protected access to your com-
puter:

case letters. The introduction of case sensitivity has these 
important consequences:

 from computers run-
00,1 type passwords 
List has passwords 
 all capitals, or assign 

 passwords assigned 
omputers that have 
nnect to your com-
s.

en your computer to 
t require that they 
vices, drives, and fold-

ithout password 

nkBar.

ublic System). Then 

es and locking privi-

ess to drives and fold-
n see page 48.

 LapLink Pro, 
er.
1 Click the Security button on the LinkBar.

2 On the General tab, click Log-in List Only (Protected Sys-
tem).

3 Click the Log-in List button, and then click the Add button.

4 On the General tab, type the log-in name and the password 
the user must provide to make a connection to your com-
puter.

Reenter the password and click OK to confirm.

5 Under Services, check File Transfer, Remote Control, or 
any of the other services you want to make available to the 
user.

6 Under Locking Permissions, check options to determine 
whether the user can blank the screen of your computer 
and disable its mouse and keyboard.

TIP You can grant locking permissions only if you select 
Remote Control as an available service.

7 To deny access to particular drives and folders, click the 
Folder Security tab. For more information see page 48.

8 To specify whether or how a user opening a connection by 
modem is to be called back, click the Modem Callback tab. 
For more information, see page 52.

Specifying passwords
LapLink Gold passwords are case-sensitive (i and I, for 
example, are treated differently). For incoming connections 
from computers running LapLink Gold, you can specify 
more secure passwords by mixing capital letters and lower-

CAUTIONFor incoming connections
ning versions earlier than LapLink 20
using ALL CAPITALS. If your Log-in 
for such connections, retype them as
new passwords.

CAUTIONIf your Log-in List contains
in an earlier LapLink version, other c
also upgraded may not be able to co
puter until you assign new password

Setting up a public system
If security is not an issue, you can op
any LapLink users. Though you do no
type a password, you can limit the ser
ers they can access.

To allow access to your computer w
protection:

1 Click the Security button on the Li

2 On the General tab, click Anyone (P
click the Public Privileges button.

3 On the General tab, check the servic
leges you want to grant.

4 On the Folder Security tab, deny acc
ers as you wish. For more informatio

1 Versions before LapLink 2000 include
LapLink Tech, and LapLink 7.5 or earli
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When you open your computer to incoming connections, you specify whether all drives and
or only certain ones—are accessible to users who connect to your computer for File Transfer.
deny access to an entire drive or to any parts of one, and you can grant different privileges to 
users. 

Folders remov
Log-in List entr
...do not appea
dows on a rem
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Opening your computer to incoming connections does not 
mean that files on all your drives and folders must be acces-

3 Click the Add button to create an entry in the Log-in List.

ng entry, highlight it in 
 Edit button.

n click Only Allow 

and folders.

rives and folders on 
u do in a File Transfer 
ble-click a drive or 
.

ht each one you want 
w button.

 folder security for a 
tem (no password 
n the LinkBar and 
en click the Folder 
sible to other users. You can “hide” certain drives and fold-
ers so that other users will not see them in their File Transfer 
windows and cannot copy files to or from them.

CAUTIONDenying access to a drive or folder makes it 
invisible to anyone who connects for File Transfer but has 
no effect in Remote Control. Anyone who connects for 
Remote Control can still access all of your files.

You can set up drive and folder security when you secure 
your computer using the Log-in List. Specify a different 
setup for each entry in the list if you like.

Until you specify otherwise, every user in your Log-in List 
has access to all of your drives and folders.

To limit access to certain drives and folders:

1 Click the Security button on the LinkBar.

2 Ensure that Log-in List (Protected System) is selected, and 
click the Log-in List button.

TIP If you want to change an existi
the list of current users and click the

4 Click the Folder Security tab and the
Access as Specified Below.

Access is now denied to all drives 

TIP You can navigate through the d
the Folder Security tab much as yo
window. For fastest navigation, dou
folder or click the plus sign beside it

5 In the list of drives and folders, highlig
to make accessible and click the Allo

TIP You can also specify drive and
computer designated as a public sys
required): Click the Security button o
click the Public Privileges button. Th
Security tab.
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When you open your computer to incoming connections, it’s a good idea to include Lockout
so that anyone who supplies an incorrect password more than a particular number of times is
access to your computer. You enable Lockout and set the number of allowable tries as part of
setup.

Like combination safes, security passwords can be 
cracked. Password crackers use a variety of techniques; 
some techniques are more sophisticated than others, but 
almost all require guessing.

To guard against unauthorized acces
anyone who makes repeated attemp
word for entry to your computer.

Suppose you are setting up your offic
from home. In the Log-in List of LapLin
yourself both a log-in name and a pa

Use Lockout
against some
attempts to g
passwords.

As set up he
will take effec
failed attemp
in name.

Someone su
log-in name N
has been loc
won’t be able
even if he or 
the correct pa
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Though you are careful to specify as secure a password as 
possible, you still want to have Lockout as additional protec-

You can reset to zero the count for any or all of the log-in 
names. This action also makes a locked out name usable 

 labeled Locked Out, 
y whenever a user 
 the correct password.

le log-in name:

 Reset User button.

-in names:

nd capitals), num-

ries. (Some pass-
ictionaries to guess 

mplex or long that 

 days.

rom versions earlier 
They must be all 
tion. So you instruct LapLink to refuse entry after a certain 
number of incorrect passwords.

To lock out anyone who repeatedly tries to connect 
using incorrect passwords:

1 Click the Security button on the LinkBar.

2 On the Lockout tab, check this box: Lock Out User after 
Repeated Wrong Passwords.

3 In the Lock Out After This Many Wrong Passwords box, 
click the number you want to allow before Lockout takes 
effect.

TIP The lower the number, the less the security risk.

4 Click OK.

Monitoring failed log-in attempts
Lockout is designed to monitor and control access accord-
ing to the log-in names in your Log-in List. A separate count 
of failed attempts is kept for each log-in name; when a count 
reaches your maximum (step 3 above), users can no longer 
connect using that log-in name.

Beside the log-in names listed on the Lockout tab appear 
numbers for the number of incorrect passwords. When a 
count reaches the maximum, the log-in name is labeled 
Locked Out.

once again.

TIP Unless a log-in name has been
its count is reset to zero automaticall
connects using that log-in name and

To reset to zero the count for a sing

• Click the log-in name and click the

To reset to zero the count for all log

• Click the Reset All button.

Tips for more secure passwords
• Use at least six characters.

• Include letters (both lowercase1 a
bers, punctuation, and symbols.

• Avoid any words found in dictiona
word-cracking programs rely on d
passwords.)

• Don’t make your passwords so co
you can’t remember them.

• Change your passwords every 45

1 Passwords for incoming connections f
than LapLink 2000 are the exception. 
capital letters.



Allowing or requiring callbacks

be called 
o be called 
he other 

. The connection to 
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Hello. I’ll call you 
back if you give 
me your current 
phone number.

Otherwise, I’ll 
have to discon-
nect.

Hello. Do you 
want me to call 
you back at 555-
2222?

Otherwise, I’ll 
have to discon-
nect.
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When you allow incoming modem connections, you can require that the remote computer 
back before a connection is opened. Or you can let the remote computer determine whether t
back. In both cases you can supply the phone number ahead of time or leave the number to t
computer. You set callback options in the Log-in List.

A callback occurs when a remote computer attempts to 
connect to your computer by modem; instead of completing 
the connection, LapLink reverses the call by hanging up 

and then dialing the remote computer
your computer is completed when the
answers.

Hello. I’ll call you 
back if you give 
me your current 
phone number.

Otherwise, I’ll con-
nect you without 
reversing the call.

Hello. Do you 
want me to call 
you back at 
555-1111?

Otherwise, I’ll con-
nect you without 
reversing the call.
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You can use callbacks as a security measure: require a call-
back to a phone number you specify. Or you can use call-

• Optional, Specified Number Only Lets the 
remote user decide whether to be called back to the 

the connection with-
ber you specify in the 
led for the callback.

uires remote users to 
to specify the number 
ary from session to 

 Only Requires the 
o the number you 
ox.

which you must specify 
 the Phone Number 

ny prefixes or suffixes 
uter from this one. 
 not apply here.)

omputers that con-
e agents will not fin-
llbacks.
backs to save money, as when you are connecting to your 
office from a hotel room.

You can set callback options when you secure your com-
puter using the Log-in List. Specify a different option for 
each entry in the list if you like.

To set callback options:

1 Click the Security button on the LinkBar.

2 Ensure that Log-in List (Protected System) is selected and 
click the Log-in List button.

3 Click the Add button to create an entry in the Log-in List.

TIP If you want to change an existing entry, highlight it in 
the list of current users and click the Edit button.

4 Click the Modem Callback tab.

5 Click one of these options:

• None Prevents callbacks.

• Optional, Any Number Lets the remote user 
decide whether to be called back; users who choose 
to be called back can specify the number to dial. This 
is the most flexible of all the options.

number you specify or to open 
out any callback. Only the num
Phone Number box can be dia

• Required, Any Number Req
be called back but allows them 
to be dialed. The number can v
session.

• Required, Specified Number
remote user to be called back t
specify in the Phone Number b

6 If you clicked either of the options for 
a phone number, type that number in
box.

Type the entire number, including a
necessary to dial the remote comp
(Your Dialing Properties settings do

TIP Do not require callbacks from c
nect by running Xchange Agents. Th
ish, because they cannot perform ca



rotected 
d a log-in 
nd access 

for users to make 
, so you make Log-in 
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you want the com-
 a gateway to a net-

puter as a host, check 
inkToNet tab.
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Allowing incoming LinkToNet calls

To allow a network computer to be used as a LinkToNet host, change the security setup to P
System and create one or more entries in the Log-in List. In each entry, specify a password an
name; then specify that anyone supplying this information can call in to through the computer a
the network and its resources.

When you set up a network computer as a LinkToNet host, 
it’s essential that you secure the computer—and thus the 
network it’s attached to—from intrusion.

Just as you create Log-in List entries 
LapLink connections to the computer
List entries for users who want to use
entry point to the network.

In a Log-in List entr
clear all services if 
puter to be used as
work exclusively.

To enable the com
the boxes on the L
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To set up password-protected access to a computer as 
a LinkToNet host:

NOTE Set up a modem-equipped computer as your own 
dial-up server. Then use LinkToNet to dial in to the network 

rmation see page 18.

 direct LapLink con-
Control or one of the 
under Services.

ese boxes are 
 Calls; and Allow 

eate in LapLink Gold, 
tically. (In fact, you 
eny this kind of 
 List from a version 

s will not allow LinkTo-
heck the LinkToNet 
1 Click the Security button on the LinkBar.

2 On the General tab, click Log-in List Only (Protected Sys-
tem).

3 Click the Log-in List button, and then click the Add button.

4 On the General tab, type the log-in name and the password 
a user must provide in order to make a connection to your 
computer.

1Reenter the password and click OK to confirm.

through that computer. For more info

5 To prevent computers from making a
nection to this computer for Remote 
other services, clear all of the boxes 

6 On the LinkToNet tab, ensure that th
checked: Allow Incoming LinkToNet
Access to the Network.

TIP In any Log-in List entries you cr
LinkToNet access is granted automa
must clear the LinkToNet options to d
access.) But if you are using a Log-in
earlier than LapLink 2000, the entrie
Net access until you edit them and c
options.

1 Passwords can contain 4–10 characters, including letters, 
numbers, symbols, and spaces. Passwords are case-sen-
sitive: mix capital letters and lowercase letters for greater 
security.
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 or by remote users.

al Security tab 
 check the Pro-
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ox. Then click 
sword button.
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Protecting your security settings with a password

Creating password protection for your LapLink security settings prevents unauthorized users
compromising your security system; it also keeps them from viewing your Address Book entri
using them to open connections to other computers. Protecting your security settings is a part
good idea if you allow others to control your computer remotely. 

Setting up password protection for your LapLink security 
settings ensures that the protections you set up for your 

computer cannot be compromised—e
using your computer in your absence

On the Loc
in Security,
tect Local S
Password b
the Set Pas
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Without knowledge of your password, users cannot view or 
change any of this information:

TIP To remove password protection, clear this box: Pro-
tect Local Security with a Password. To change the pass-

 Password button.

sed on incoming con-
 If you set up pass-
ork connections, 
tion to cable and wire-
al Security tab, check 
onnections.

1 passwords were not 
n as your password, 
 your security system 
umber of other combi-

 introduction of case 
 way to type a pass-
lace. If you inherited a 
apLink, try different 
ercase letters: initial 

 on.

 LapLink Pro, 
er.
• Log-in names, passwords, and other security settings

• Phone numbers, passwords, and other information 
stored in your Address Book entries

• Privileges you have granted to guest computers and 
other settings in Remote Control Options

In addition, the same password is required for access to 
Connect over Modem and certain Logging features.

To protect your LapLink security settings:

1 Click the Security button on the LinkBar.

2 On the Local Security tab, check this box: Protect Local 
Security with a Password.

3 In the Change Password dialog box, type the password in 
the New Password box. In the Confirm New Password box, 
type it again.

TIP Passwords are case-sensitive: capital letters and low-
ercase letters are treated differently. For more secure 
passwords, mix the two cases.

4 Click OK.

word currently in effect, click the Set

TIP By default, security is not impo
nections over a cable or by wireless.
word protection for modem and netw
however, you can extend that protec
less connections as well. On the Loc
this box: Enforce Security for Local C

Did you upgrade?
In versions earlier than LapLink 2000,
case-sensitive. If you specified azefgi
for example, you could gain access to
by typing Azefgin, AZEFGIN, or any n
nations.

Beginning with LapLink 2000 and the
sensitivity, however, there is only one
word: just as it was typed in the first p
password from an earlier version of L
combinations of capital letters and low
capital letter, all capital letters, and so

1 Versions before LapLink 2000 include
LapLink Tech, and LapLink 7.5 or earli
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Encrypting information over incoming connections

Encryption is a good idea over Internet connections and other connections where your inform
be intercepted and compromised. You can choose between two encryption methods: the one
on earlier versions of LapLink and more secure methods installed on your computer. The sett
make on a computer determine encryption for incoming connections.
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By default, LapLink encrypts log-in names and passwords, 
but nothing else. This setting is usually fine for transmitting 

4 Click a method of encryption:

ion Provides com-
an LapLink 2000.

 the Specified 
ree of security, using 
omputer. Cannot be 
ns earlier than 

ion option, click a Cryp-
ption.

 installed on the 
ter cannot connect to 

ion option—but still 
ions of LapLink (which 
e LapLink Encryption If 

mputer to a lower 
 the previous step.

efore a connection is 
 a connection won’t 
tion.

 if your computer is 
icrosoft CryptoAPI.
data over office networks or other secure connections.

On the Internet, intranets, or wide area networks, however, 
it is usually a good idea to encrypt your data, including files, 
text from chat sessions, and instructions sent to the remote 
computer during Remote Control.

While opening your computer to incoming connections, you 
determine whether and how data transmitted over those 
connections will be encrypted. (The settings on the other 
computers are irrelevant.) When you connect to another 
computer, however, it is the settings on that computer that 
determine encryption.1

To encrypt data over incoming connections:

1 Click the Security button on the LinkBar.

2 On the Encryption tab, check this box: Use Encryption to 
Send Data.

3 If you want to limit encryption to connections over a TCP/IP 
network or to dial-up connections to a TCP/IP network, 
including the Internet, check this box: Only Encrypt When 
Connecting over TCP/IP (Internet/Intranet).

• LapLink-compatible Encrypt
patibility with versions earlier th

• CryptoAPI Encryption Using
Provider2 Sets a higher deg
an algorithm installed on your c
used in connections with versio
LapLink 2000.

5 If you clicked the CryptoAPI Encrypt
toAPI provider in the box below the o

Be sure to specify a provider that is
remote computer too. That compu
your computer otherwise.

6 If you clicked the CryptoAPI Encrypt
want to accept calls from earlier vers
lack CryptoAPI)—check this box: Us
Guest Doesn’t have CryptoAPI.

CAUTIONThis option opens your co
level of security than you specified in

TIP Be sure to enable encryption b
opened. Changing the setting during
have any effect until the next connec1 The only exception occurs when you use LapLink 2000 to 

connect to a computer running a version older than 
LapLink 2000. In this case only, the settings on your 
LapLink 2000 computer determine encryption.

2 CryptoAPI encryption is available only
equipped with software written to the M
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Using Remote Control—Overview

When you open a Remote Control window on your computer, the computer in front of you b
the guest, and the remote computer displayed on your screen becomes the host. From the gu
can view and operate the host as if you were sitting in front of it. Images from the host appear 
screen in a Remote Control window within the LapLink workplace.

Remote Control provides a way to operate another com-
puter at a distance. You begin Remote Control as soon as 
you open a Remote Control window. While you are working 
in this window, your mouse moves the mouse pointer on the 
remote computer, your keyboard types characters on the 
remote computer, and your Remote Control window shows 
the remote computer’s screen.

Remote Control terminology
A LapLink Remote Control session creates two kinds of 
computers:

Guest  The Remote Control window and the mouse and 
keyboard on the guest are your links to the remote com-
puter. Working in the Remote Control window, you use your 
mouse and keyboard to operate the host. Your work, mean-
while, is being processed on the host computer.

Host  There is no special procedure associated with setting 
up a host. The computer need only be running LapLink and 
configured to allow incoming connections. You do not need 
to be at the computer. On the other hand, you may want to 
join the guest as an observer or an active participant.

Opening a Remote Control window
On a guest, you can open a Remote Control window at the 
time you connect to the host. Or you can open one some-

time after the connection is made. Be
ports multiple connections, you can m
Remote Control windows, one for eac

To open a Remote Control window

• Click the Connect button on the L
Modem, Network, or some other m
Under Services, check the Remo
more information about connectin
see chapter 2.)

To open a Remote Control window
nection:

• Click the Open Remote Control b
Or click Open Remote Control on

• If you have more than one connec
for the desired connection before 
Remote Control button.

What you see
The host screen appears on your scre
LapLink. The name of the host comp
window’s title bar. You can move, res
mize the window as you would any o
scroll bars to view other parts of the h
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If you prefer to display the host screen across your entire 
screen instead of a window, press CTRL+SHIFT+F. Press 

dow then alternates between full screen and icon; the win-
dow view is no longer available.

omize Remote Con-
 to enhance your view 
. For instance, you 
lors or prevent the 
formation see page 
CTRL+SHIFT+F again to return to the window view. For 
more information about changing your view of the host, see 
page 64.

TIP A host screen can be made to display full screen by 
default. To make this change, click Remote Control 
Options on the Options menu. On the Guest tab, check 
the Always Use Full-Screen box. The Remote Control win-

TIP There are several ways to cust
trol performance—whether you want
of the host or speed up performance
can use solid rather than dithered co
display of large bitmaps. For more in
76.
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. You can also switch 
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r entire screen is now 
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k to the window view.
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Viewing the host

As a guest, you can alternate between two views of the host screen. Your first view appears in
within LapLink. Inside the window, you control the host; outside the window, you perform othe
LapLink or in other applications on your computer. Switch to a full-screen view when you wan
maximize your view of the host and use Remote Control exclusively. When you cannot see th
host screen even in full screen, you can change the resolution of the host screen or scale its im
within your view.

Devoting your entire screen to a view of the host
You can view the host screen in two ways:

• In a window within LapLink (the default)

• As a full-screen display, hiding LapLink and the rest of 
your Windows workspace

In a window view, you have quick acc
Text Chat, and other LapLink features
to other applications on your compute

To maximize the area in which you vi
host, switch to a full-screen view. You
devoted to controlling the host; you do
your own applications. When you wa
other than control the host, switch bac

To alternate between a window and a full-screen view of 
the host, press CTRL+SHIFT+F
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To switch between window and full-screen view: You can then view all of the host screen in full-screen view. 
The original resolution is restored automatically on discon-

screen to match that 

te Control Options.

tch Host to Guest.

to its original resolu-

reen to fit  You can 
ce by scaling the 
. You always see all 

 working in full screen 
 distorted.

en to fit within your 

estores the image to 

st computer unless 
e change without 
o be running a ver-
re.
• Press CTRL+SHIFT+F.

TIP In full screen, you can also switch to a window from 
the copy of LapLink running on the host: If LapLink is an 
icon, click it to restore it to a window. Then click the icon 
representing your Remote Control window, and click 
Guest Full Screen to clear the check mark.

TIP To make Remote Control alternate between full 
screen and icon, bypassing the window view, click 
Remote Control Options on the Options menu. On the 
Guest tab, check the Always Use Full-Screen box.

Viewing the entire host screen at once
There are two ways to fit the host screen into your view:

• From your computer, lower the resolution of a higher-
resolution host screen to match that of your screen.

• Scale the image of the host screen to fit within your 
view.

Temporarily changing the resolution of the host 
screen  When using a laptop to control a desktop, you 
often can’t view the entire host screen at once if the desktop 
operates at a higher screen resolution. From your laptop, 
you can lower the desktop’s screen resolution to match your 
laptop’s.1

nect or at your direction.

To lower the resolution of the host 
of your screen:

1 On the Options menu, click Remo

2 On the Guest tab, check this box: Ma

Clearing the box restores the host 
tion.

3 Click OK.

Scaling the image of the host sc
also view the entire host screen at on
image to fit within the LapLink window
of the host’s screen, whether you are
or window, though the image may be

To scale the image of the host scre
view:

• Press CTRL+SHIFT+S.

• Pressing CTRL+SHIFT+S again r
normal.

1 You cannot lower the resolution of a ho
its monitor and display adapter allow th
restarting Windows. The host must als
sion of LapLink that supports this featu
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Customizing keyboard control

By default, Windows system keys pressed on the guest computer take effect on the host. If 
the system keys to operate on the guest while working in a Remote Control window, click Remo
Options on the Options menu. Then on the Guest tab, click Execute on Guest. Through Remo
Options, you can also change the key combinations that control your view of the host.

Windows system keys
Windows system keys are key combinations that perform a 
variety of tasks. Pressing ALT+TAB, for example, switches 
to the program you used last. By default, LapLink sends 

most system keys to the host during R
ing ALT+TAB on the guest, therefore,
gram last used on the host.

When you are w
Control window,
other Windows 
press on your co
take effect on th
(the host).

To have system
your computer i
computer, click 
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You can make system keys work on your own computer 
(the guest) when you are working in a Remote Control win-

full-screen and window view of the host. Pressing 
CTRL+SHIFT+S switches between scaled-to-fit and normal 

ion.)

mbinations to certain 
ence with other 
you are limited in your 

y combinations:

te Control Options.

e boxes:

 the shortcut key that 
and window view.

 shortcut key that 
t and normal view.

inations (where n is a 
dow.

TIP Windows system keys (except 
CTRL+ALT+DELETE) always take effect on the host 
when you are using Remote Control in the full-screen 
view.

TIP If you intend to control a remote computer using the 
keyboard exclusively (without a mouse), set the Windows 
system keys to execute on your computer (the guest). 
When you want the keys to execute on the remote com-
puter (the host), switch to the full-screen view.

To execute Windows system keys on the guest:

1 On the Options menu, click Remote Control Options, 
and then click the Guest tab.

2 Click Execute on Guest.

3 Click OK.

Remote Control shortcut keys
LapLink offers two shortcut keys to change your view of a 
host screen. Pressing CTRL+SHIFT+F switches between 

view. (See page 64 for more informat

You can change these default key co
other combinations. (To avoid interfer
LapLink and Windows shortcut keys, 
choice of replacements.)

To change the LapLink shortcut ke

1 On the Options menu, click Remo

2 On the Guest tab, click in one of thes

• Full-screen Toggle Changes
alternates between full-screen 

• Scaling Toggle Changes the
alternates between scaled-to-fi

3 Press any of the following key comb
number or a letter):

SHIFT+ALT+n 
CTRL+SHIFT+n
CTRL+ALT+n
CTRL+SHIFT+ALT+n
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Disabling the host keyboard and mouse and blanking its s

From a guest computer, you can ensure privacy and prevent interruptions at the host by disa
keyboard and mouse and blanking its screen. To perform any of these “locking” operations fro
guest, click the appropriate command on the Session menu. On the host, you can allow lockin
changing the default security setup.

On the host: Allow u
the screen and disab
and mouse when you
access through the L

On the guest: Blank
and disable its keybo
on the Session menu
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Locking the host from the guest long as they are allowed by the host. For information on 
using Address Book to make connections, see chapter 2.

 who can lock it and 
ock the host without 
s you grant cannot be 
ssion.

g depends on how 
t to use Text Chat, for 

ging the security 
 Security button on the 

Log-in List (Protected 
entries. In each entry, 
er Locking Permis-
 to guests whom you 
 name and password. 
 up a Log-in List, see 

e system to any 
 (Public System). 
 On the General tab, 
d then check any of 
rmissions. The per-
With the permission of the host computer, you can:

• Blank the host screen The host’s screen is dark-
ened, preventing your work from being viewed at the 
host.

• Disable the host mouse The host’s mouse is locked, 
preventing anyone at the host from using the mouse to 
interrupt your work.

• Disable the host keyboard The host’s keyboard is 
locked, preventing anyone at the host from using the 
keyboard to interrupt your work.

To lock the host during a Remote Control session:

• On the Session menu, click any of these commands to 
place a check mark beside the command: Blank Host 
Screen, Lock Host Mouse, or Lock Host Keyboard.

• To disable locking, click the command again to clear 
the check mark.

TIP If a command is dimmed, it is not available: either the 
host cannot perform the action, or the security setup of the 
host computer does not allow it.

TIP The Session menu is available only when you are 
connected to another computer.

TIP Through Address Book, you can request the kinds of 
locking you want to take effect as soon as you open a 
Remote Control session. Your requests will be honored as 

Configuring a host for locking
You can configure a host to determine
how it will be locked. Guests cannot l
your permission, and locking privilege
changed during a Remote Control se

Whether you permit any kind of lockin
you intend to use LapLink. If you wan
example, there should be no locking.

You grant locking permission by chan
setup on the host computer: Click the
LinkBar. You then have a choice:

• Set up a Log-in List by specifying 
System) and adding one or more 
check any of the three boxes und
sions. The permissions apply only
provide with the appropriate log-in
For more information about setting
page 46.

• If security is not an issue, open th
LapLink user by clicking Anybody
Click the Public Privileges button.
check the Remote Control box, an
the three boxes under Locking Pe
missions apply to all guests.
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Rebooting and logging on to the host

From a guest computer, you can reboot a host computer and restart Windows. To reboot a ho
guest during Remote Control, click the Reboot Host command on the Session menu. To config
for rebooting and restarting Windows, click Remote Control Options on the Options menu.

Rebooting the host from the guest
From a guest computer you may want to restart a host to 
put into effect changes you have made on that computer. 
Or you may want to restart a host computer to ensure that 
no one else can call in after you disconnect.

To reboot the host from the guest d
trol:

• On the Session menu, click Rebo

If Reboot Host is dimmed on the S
has not set the option to allow rebo

On the host: Allow u
the computer in Remo
Options.

On the guest: Reboo
the Session menu.
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Logging onto Windows NT from the guest • Always Reboot When Guest 
Disconnects Check this box to require that the 

uest breaks a con-
ken accidentally.

r a reboot
a host for rebooting, 
n resume a LapLink 

 You can do this by 
indows is started.

atically runs 
ted:

 Options (Options 
art LapLink before 

n a Windows NT host 
+DELETE at logon, a 
ation specified on the 

 

l Options (Options 
L+ALT+DELETE to 
sses This Key Com-

s (where n is a number 
IFT+n, CTRL+ALT+n, 
Depending on how a Windows 95 or Windows 98 computer 
is set up, you may or may not be prompted to log on to Win-
dows. On every Windows NT computer, however, you must 
always press CTRL+ALT+DELETE before you can log on 
to Windows.

To send CTRL+ALT+DELETE to a Windows NT host, do 
one of these:

• Press the key combination specified for this purpose on 
the host.

• On the host’s Session menu, click Send 
CTRL+ALT+DELETE to the Host.

• Click the Remote Control icon at the bottom of the 
host’s LapLink workplace, and then click Feed 
CTRL+ALT+DELETE.

Configuring the host for rebooting
You must configure a host to allow any guest to restart it 
during a Remote Control session. You can also require that 
the host be restarted whenever a Remote Control connec-
tion is interrupted.

To configure a host computer for rebooting:

• On the Host tab of Remote Control Options (Options 
menu), check either or both of these boxes:

• Allow Guest to Reboot on Command Check this 
box to allow guests to restart the host using the 
Reboot Host command on their computers.

host be restarted whenever a g
nection or the connection is bro

Ensuring access to the host afte
At the same time you are configuring 
you can configure it so that a guest ca
connection after the host is rebooted.
setting up LapLink to run whenever W

To configure a host so that it autom
LapLink each time Windows is star

• On the Advanced tab of Program
menu), check this box: Always St
Windows Logon Prompt.

Logging on to Windows NT  Whe
requires the user to press CTRL+ALT
guest can press a special key combin
host.

To specify the key combination for
CTRL+ALT+DELETE:

1 On the Host tab of Remote Contro
menu), click in this box: Send CTR
This Computer When a Guest Pre
bination.

2 Press one of these key combination
or letter): SHIFT+ALT+n, CTRL+SH
or CTRL+SHIFT+ALT+n.
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Hosting a Remote Control session

When you allow your computer to be controlled from a remote computer, your computer be
host to a guest computer. For Remote Control to take place the host need only be running Lap
do not need to be at the computer. Sensitive information is protected by the conditions of the c
You can grant greater access, or limit these conditions, through the LapLink security system.

After installatio
security setting
puter to accept
tions and serve

To host a Remo
leave LapLink r
you wish.)
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When you control a host, you control who can connect to 
that computer and the kinds of services they can use. For 

tified by the name of the remote computer. Clicking this icon 
displays a Windows menu with standard commands. Click-

connection.

kplace remain a win-
emote Control 
en click the Host tab. 
en This Computer Is 

sion
nd you want to switch 
ontrolling the remote 

ntrol, the current 
broken on either com-
, you open a Remote 
 the other computer.

on when a Remote 
ure that there is at 
, such as File Trans-
ice in use, open 
g Remote Control.
example, you can limit a guest to Remote Control only, or 
you can allow access to Text Chat and File Transfer as well. 
You can even allow a guest to blank your computer’s 
screen or disable the mouse and keyboard. All of these 
options are set in the LapLink security system.

You can leave the host computer unattended, giving an 
authorized user exclusive control. Or you can stay at the 
computer and interact with the guest by trading off control. 
For example, the two of you could edit a document together, 
participate in a training session, or explore a new program.

TIP A host can be controlled by only one computer at a 
time. In the meantime, however, other computers can con-
nect to the host using any other services than Remote 
Control.

What you see on a host
When a guest connects to your computer and begins 
Remote Control, your LapLink workplace is minimized. If 
you double-click the icon, the LapLink workplace is restored 
to a window.

At the bottom of the restored LapLink workplace, you see 
an icon for the Remote Control connection. The icon is iden-

ing Close closes the Remote Control 

TIP You can make the LapLink wor
dow when a guest connects: Click R
Options on the Options menu, and th
Clear this box: Minimize LapLink Wh
a Host.

Reversing a Remote Control ses
There may be times when the guest a
roles so that you become the guest c
computer.

To reverse the direction of Remote Co
Remote Control connection must be 
puter. Then, as the prospective guest
Control window and begin controlling

TIP To avoid breaking the connecti
Control connection is closed, make s
least one other service window open
fer. If Remote Control is the only serv
another service window before closin
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Sharing clipboard information with remote computer

Computers in a Remote Control connection share a common clipboard: you can copy or cut i
to the clipboard on one computer and paste this information on another. Only information put 
clipboard during a Remote Control session is available to other computers.

When you cut or copy information for pasting in another 
document, the information is stored temporarily in the clip-
board. Normally, clipboard information is transferred 
between documents on the same computer. When you use 
Remote Control, however, you can use the clipboard to 
transfer information from one computer to another. You can 
copy text or graphics on the host computer, for example, 
and paste it on the guest.

If you are controlling several computers at the same time, 
information you cut or copy on any of the linked computers 
can be made available for pasting on any of the others.

TIP Only information placed in the clipboard during 
Remote Control can be pasted on other computers. You 
cannot share any information copied or cut to a clipboard 
before a Remote Control connection is opened.

TIP When you clear the contents of the clipboard on one 
computer, you clear the clipboard contents of the other 
computer as well.

Pasting from the clipboard during Remote Control
When you copy or cut information to the clipboard during 
Remote Control, only a small part of the information is trans-
ferred to the other computer immediately. The rest of the 
information is transferred when you paste.

To prevent the loss of information add
from the remote computer during Rem
information before disconnecting.

If you are controlling several remote c
in the clipboard on your computer is a
remote computers. If you want to tran
tion from one remote computer to ano
must first paste the information into a
computer; then paste it into a docume
computer.

Disabling clipboard sharing
Clipboard sharing is available during 
sions unless you disable it.

To disable clipboard sharing:

1 Open a Remote Control connectio
puter.

2 On the Edit menu, click Link Clipboa
mark.

If there is data in the common clipb
transferred completely, you are ask
plete the transfer.
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TIP To enable clipboard sharing again, repeat the proce-
dure to restore the check mark to Link Clipboards. Only 

data placed in the clipboard after you enable this option 
can be shared with other computers.
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Customizing Remote Control performance

As a guest, you can change several Remote Control settings either to speed up performanc
enhance your view of the host screen. When speed is your priority, change the settings to enh
performance. When you want the best view of the host screen, turn off the performance enha
To change performance settings, click Remote Control Options on the Options menu, and the
Performance tab.

To improve Remote Control performance, LapLink tempo-
rarily alters the host screen by removing its wallpaper, 
screen saver, and other visual enhancements. You can 
restore any of these enhancements. Or you can improve 
performance even more by minimizing the number of bit-
maps and bitmap colors transferred over a connection.

To change Remote Control perform

1 On the Options menu, click Remo

2 On the Performance tab, click either

• Best Quality Improves the a
and does not change the appe
screen except to disable its scr

Choose between enha
view of the host screen
up Remote Control pe

Click one of the preset

Or click the Settings b
specify your own setti
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• Best Performance Displays smaller bitmaps in 
black and white and does not show larger bitmaps at 

appear in some dialog boxes, wizards, and buttons. (Exper-
iment with the setting, increasing it as necessary to display 

 options:

lors instead of dith-
ce is not affected, but 

ed to display bitmaps. 
to True Color (24 bit). 
 improve performance.

creen
ontrol Options to alter 
 appearance of the 
ect, the host screen is 

e settings:

 host’s screen saver 

  Disables several 
wallpaper or patterns, 
ew.
all; also changes the appearance of the host screen 
to maximize performance.

3 To customize the settings for any of these options, click the 
Settings button.1

Changing your view of the host screen
Click the Settings button in Remote Control Options to 
change the quality of your view of the host screen without 
affecting the host screen itself.

On the Guest Display tab, adjust these options:

Send Font Information  Displays text and symbols on 
the guest computer. Checking this box speeds display per-
formance but may not present the most accurate represen-
tation of text and symbols.

Prevent Display of Large Bitmaps  Determines the 
size of the largest bitmap to be displayed in your view, rang-
ing from 32 by 32 to 512 by 512 pixels. Choosing a smaller 
size improves performance but may cause bitmaps not to 

larger bitmaps.)

On the Guest Colors tab, adjust these

Use Solid Colors  Displays solid co
ered, or patterned, colors. Performan
your view of the host may improve.

Bitmap Color  Selects the palette us
The values range from Monochrome 
Choose a palette with fewer colors to

Temporarily changing the host s
Click the Settings button in Remote C
your view of the host by changing the
host screen itself. When you disconn
restored to its original appearance.

On the Host Display tab, change thes

Disable Screen Saver   Keeps the
from running.

Disable Special Windows Effects
Windows features, including desktop 
animated windows, and Web Page vi

1 Performance options are set at Typical during installation. 
They are reset to User Customized whenever you click the 
Settings button and make changes.
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Using File Transfer—Overview

Once you have connected to another computer and opened File Transfer windows, you are
transfer files between the computers. First, display your target, and then select the files you wa
transfer. If you want the files on both computers, copy them. If you want to transfer the files to 
computer and delete them from the other, move the files.

You can open File Transfer windows at the time you con-
nect to a remote computer. Or you can open File Transfer 
windows sometime after the connection is made.

NOTE:In Windows, folder and subfolder are used in place 
of directory and subdirectory.

To open File Transfer windows:

• Click the Open File Transfer butto
click Open File Transfer on the W

Two File Transfer windows appear
computer, one for your computer. U
you can view all the files on any dri
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Step one: display the target • To select more than one item, do either of the following:

ach item.

ed next to each other, 
IFT while you click 

f files or folders by 
 and dragging to the 
ox.

plifies file transfers. 
copying and moving: 
 other computer, leav-
ving puts the files on 
als.

:

 and your left mouse 
rget folder.

T and your left 
 the target folder.

 or SHIFT, files are 
rive or computer and 
ation on the same 
Since you will be using the drag-and-drop method of copy-
ing and moving files, first find your target and make it visible 
on your screen. A target is the drive or folder you want to 
transfer the files to.

To display the target:

1 Identify the target window: it may be the window for your 
computer or the remote computer—whichever you want 
to receive the files.

2 On the left side of the target window, double-click the target 
drive.

3 Click the target folder. Its contents now appear on the right.

4 If you are looking for a subfolder, click the plus sign (+) 
beside the folder containing the subfolder. Then click the 
subfolder itself.

NOTE:To determine which File Transfer window is which, 
look for the computer name in the title bar, at the top of 
each window.

Step two: select the files
In the opposite File Transfer window, select the files you’ll 
be transferring to the target you just displayed.

To select the folders and files you want to transfer:

• On the right side of the window, click the folder or file 
you want to transfer.

• Hold down CTRL as you click e

• To select two or more items list
click the first item and press SH
the last item.

NOTE:If you prefer, select a group o
clicking at a right corner of the group
opposite corner to form a selection b

Step three: drag and drop
Using the drag-and-drop method sim
Keep in mind the difference between 
Copying puts a copy of the files on the
ing the originals where they were. Mo
the other computer, deleting the origin

To drag and drop the selected files

• To copy the files, hold down CTRL
button as you drag them to the ta

• To move the files, hold down SHIF
mouse button as you drag them to

TIP If you drag without using CTRL
copied when you drag to a different d
moved when you drag to another loc
drive.
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Navigating through drives and folders

Each File Transfer window is split into a left and a right side. The left side is designed for nav
through drives and folders: click or double-click a drive or folder to open it and display its conten
right side, you see the contents of the open drive and folder. Commands on the View menu le
change the appearance and the order of the contents.

Click a drive or folder to open it, with-
out showing its contents.

Click a plus sig
tents of a drive
opening it. Click
the contents.

Double-click a drive or folder to open 
it and show its contents.
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Follow these guidelines to navigate through the left side of a 
File Transfer window:

By default, the contents appear in Detail view: file name, 
size, type (based on the MS-DOS name extension), modifi-

ems displayed on 
dow:

ese commands: 

ference. To return to 

ange the folders and 
r window according to 

ders:

ge Icons; then click 
e, By Type, By Size, 

tail view, you can sort 
extension), modifica-
ponding button at the 
utton again reverses 
• Double-click a drive or folder Opens and expands 
the drive or folder, displaying its subfolders immediately 
below. (Double-clicking is the fastest way to navigate 
downward in a hierarchy of folders.)

• Click a drive or folder Opens the drive or folder with-
out expanding it.

• Click a plus sign (+) Expands the drive or folder, dis-
playing its subfolders immediately below. The drive or 
folder is not opened.

• Click a minus sign (-) Collapses the drive or folder, 
hiding its subfolders.

NOTE:Want to locate a particular folder or file? Type the 
first letter of its name. The highlight moves to the next item 
beginning with that letter. Typing the letter again finds the 
next occurrence.

Changing the view
When you open a drive or folder, you see its contents—sub-
folders and files—on the right side of the File Transfer win-
dow.

cation date, and attributes.

To change the appearance of the it
the right side of a File Transfer win

• On the View menu, click one of th
Large Icons, Small Icons, or List.

Try the different views to find your pre
the original view, click Detail.

Sorting files and folders
Regardless of the view, you can rearr
files on the right side of a File Transfe
name, size, date, and so on.

To change the order of files and fol

• On the View menu, point to Arran
one of these commands: By Nam
By Date, or By Attributes.

TIP If you are displaying files in De
them by name, size, type (file name 
tion date, or attribute: click the corres
top of a column. Clicking the same b
the order.



t side, you 
button. To 
 last item. 
 Select All 
e item.

r side of a File Trans-
ultiple folders only on 

y dragging 
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n CTRL 
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Selecting files and folders

On the left side of a File Transfer window, you can select only one folder at a time. On the righ
can select multiple folders and files. To select a single item, point to it and click the left mouse 
select several items in sequence, click the first item; then hold down SHIFT while you click the
To select items out of sequence, hold down CTRL while you click each one. You can also click
or Select By on the File menu. To cancel an individual selection, hold down CTRL, and click th

You must select a folder or file before you can copy or move 
it. When you select an item, its name and icon are high-
lighted.

You can select a single folder on eithe
fer window. You can select files and m
the right side.

Select a group of items b
a selection box around t
right to left.

Select several items not
together by holding dow
while you click the items
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NOTE:By default, selecting a folder selects all of its files 
and its subfolders. To change the default, click File Trans-

To select folders and files using the Select By com-
mand:

ile or folder. Or use wild-
mes.

 all files with the .DOC 
ts all files and folders.

nce by typing them 
pace or a comma 
 *.DOC,*.TXT dis-
.

e, check the Enable 
e dates and times 

he item.

ction.
fer Options (Options menu). On the Filter tab, clear this 
box: Include Subfolders in Copies. (You can always over-
ride this setting when you are asked to confirm a copy or 
move operation.)

To select a single file or folder:

• Place the mouse pointer on its name or icon, and click 
the left mouse button.

To select a group of items, do either of the following:

• Click the first item, and press SHIFT while you click the 
last item.

• Click at a right corner of the group and drag to the 
opposite corner to form a selection box.

To select two or more items out of sequence:

• Press CTRL while you click the items.

To select all folders and files in the current folder:

•  On the File menu, click Select All.

TIP To select everything on a drive, click the drive and 
then click Select All.

1 On the File menu, click Select By.

2 In the Filter box, type the name of a f
cards to specify items with similar na

For example, typing *.DOC selects
extension. The default (*.*) selec

You can specify several criteria at o
one after another and inserting a s
between them. For example, typing
plays all files with those extensions

3 If you want to select according to dat
Date/Time Range box. Then type th
under Oldest File and Newest File.

4 Click OK.

Clearing selections
To clear an individual selection:

• Hold down CTRL while you click t

To clear all selections:

• On the File menu, click Clear Sele
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Copying or moving files and folders

Once you have displayed the target and selected the items to be transferred, you are ready
Copy or Move command. Or you can use the mouse to drag the items and drop them onto th
Before the transfer is completed in either case, you see a confirmation dialog box showing de
operation you are about to perform. You can then proceed immediately, change certain condit
cancel the operation entirely.

When you copy or move, you transfer items from one loca-
tion—the source—to another—the target. You can transfer 

items using the Copy or Move comm
them with the mouse.

Before copyin
can confirm th
selected the s
as you intend
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To prepare for a copy or move operation: You now see the File Copy or File Move dialog box, as 
described next.

s buttons on the tool-
r window.

g box, you can verify 
 the target, and set 

 can choose a differ-
er list; in the Folder 
 folder already on the 

he boxes as you 
 page 88.

r Cancel to halt it.

 on the operation as it 
peration. If the Pro-
lect the files you want 

selections at the high-

 selections inside the 

lections on the same 
1 Navigate through the left side of the target window to 
display the folder where you want to put the selections. 
Click the folder. (For more information, see page 82.)

2 In the source window, select the items you intend to transfer. 
Make sure that the source and the target are still showing. 
(For more information, see page 84.)

NOTE:Before attempting to transfer between computers, 
open a File Transfer window for each of them.

To copy or move using drag and drop:

1 Place the mouse pointer over a single item or one of 
several items you have selected on the source.

2 Do either of the following:

• To copy, press CTRL and your left mouse button as 
you move the pointer over to the target folder.

• To move, press SHIFT and your left mouse button as 
you move the pointer over to the target folder.

3 Once the target is highlighted, release the mouse button 
and the CTRL or SHIFT key.

You now see the File Copy or File Move dialog box, as 
shown on the previous page.

To copy or move using a command:

• With the source window still active, click Copy or Move 
on the File menu.

NOTE:Copy and Move also appear a
bar near the top of each File Transfe

To complete the copy or move:

1 In the File Copy or File Move dialo
the source and the target, change
options. Do any of the following:

• Under To, verify the target. You
ent computer from the Comput
box, you can type any drive and
target.

• Under Options, check or clear t
wish. For more information, see

2 Click OK to complete the operation o

You now see a dialog box reporting
proceeds. Click Cancel to halt the o
tected Files dialog box appears, se
to transfer, and click OK.

TIP Dropping onto a drive puts the 
est level of the hierarchy of folders.

TIP Dropping onto a folder puts the
folder.

TIP Dropping onto a file puts the se
level as the file.
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 a copy or 
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Setting File Transfer options for the results you want

Certain File Transfer options play a crucial role when you are copying or moving files. Depen
how you set them, you can include or exclude subfolders, prevent the overwriting of files excep
copies, or copy only files you have backed up before. To specify global preferences for these 
click File Transfer Options on the Options menu; then click the Filter tab. Whenever you confirm
move operation, you can change the settings for that operation.

There are three File Transfer options that determine which 
files are transferred and which are overwritten:

• Transfer Only If Files Are Newer

• Include Subfolders in Copies

• Transfer Only If Files Are Already

The first two options are in effect until

Set global options on the Filter tab of F
Transfer Options.

When copying or moving, verify the se
before clicking OK to continue.
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To change your global preferences for File Transfer 
options:

folders you have selected. When the box is cleared, your 
selection is limited to the selected files and folders (including 

ithin folders are 

Files Are Already on 
g older copies of files 
d for anyone who reg-
o matter how many 

ose already on the tar-
nored.

 first time, copy the 
. When you are ready 
x.

 hard drive are “recy-
Recycle Bin, where 

ermanently removed 
 the computer that 

 you delete them in 

ansfer Options.

ve Deleted Files and 
• On the Options menu, click File Transfer Options. Click 
the Filter tab, and then check the appropriate boxes.

When you transfer files, you can tailor these options for that 
operation before giving your confirmation.

NOTE:Before transferring files between computers, 
ensure that their clocks are reasonably in sync. If they are 
not, files that appear to be older may actually be newer, 
and you could lose your most recent work.

Protecting newer copies of files
One of the options—Transfer Only If Files Are Newer—is 
designed to preserve files that represent your most recent 
work. It is also useful for speeding up file transfers; files that 
do not need to be updated are excluded from the operation.

When the box is checked, Transfer Only If Files Are Newer 
ensures that files are not overwritten by older copies of 
those files. (Files not already on the target will be copied 
anyway.) When the box is cleared, files are overwritten with-
out regard to their dates and times.

Including or excluding subfolders
One of the options—Include Subfolders in Copies—is 
designed for copying a hierarchy of folders and subfolders 
and is potentially the most powerful of the File Transfer 
options. It can make the difference between copying hun-
dreds of files or only a few.

When the box is checked, Include Subfolders in Copies 
extends your selection to include any subfolders within the 

the files in those folders); subfolders w
excluded.

Updating older copies of files
One of the options—Transfer Only If 
Target—simplifies the task of updatin
without adding new ones. It is designe
ularly updates the same set of files. N
files you select on the source, only th
get will be copied; the others will be ig

In preparation for using this option the
files to the target with the box cleared
to update the same files, check the bo

Deleting to the Recycle Bin
By default, any files you delete from a
cled,” that is, moved to the Windows 
you can retrieve them later.

NOTE:Whether files are recycled or p
is determined solely by the setting on
opens the connection.

To permanently remove files when
LapLink:

1 On the Options menu, click File Tr

2 On the Delete tab, clear this box: Mo
Folders to the Recycle Bin.
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Synchronizing folders with SmartXchange

Use SmartXchange to synchronize two folders in a two-way exchange of files. You can limit
of the operation by including only the files already in both folders. You can also use SmartXch
update a backup folder quickly. In either case, older files are overwritten, but no files are delete

Synchronizing folders
If you have ever copied files back and forth between com-
puters so that they share the latest files, you have synchro-
nized. Unlike the usual copy operation, synchronization 
works in two directions: from one folder to the other and 
back again.

NOTE:With SmartXchange, you determine the items to be 
copied by selecting the folder containing the items, not by 

selecting the items themselves. Sele
left side of a File Transfer window.

With SmartXchange, you can accom
tion, one folder at a time. You can incr
operation by including subfolders with
limit its scope by exchanging only the
folders already.

Files are overwritten when there are 
newer copies in the other folder.

In SmartXchange

After SmartXchange, the two folders 
are identical.

Files are not copied when there are 
identical copies in both folders.

Files are copied when they are in 
one folder but not the other.
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CAUTION:SmartXchange is a tool for exchanging files 
between folders. It does not merge the contents of files. If 

Already on Target. If you want the two folders to be 
identical, the box must be cleared.

ne-way Transfer Only.

implify the process of 
acked up a set of files.

backup folder:

up) window, click the 

, click the folder con-
again.

tXchange.

correct. Change the tar-

s in the exchange, 
ers.

 not add new ones—
 Files Are Already on 
o be identical, the box 

ne-way Transfer Only.
you need to merge databases, schedules, or other shared 
files, see the documentation for the program in which they 
were created.

TIP If you synchronize the same folders on a routine 
basis, consider using Xchange Agent instead of SmartX-
change. Xchange Agent automates the process of open-
ing connections, selecting the pairs of folders to be 
synchronized, setting the appropriate options, initiating the 
exchange, and disconnecting. For more information, see 
page 100.

To use SmartXchange to synchronize folders:

1 On the left side of each File Transfer window, click the 
folder (not an entire drive) containing the files you want 
to exchange.

NOTE:To verify which folder is open, look at the title bar, at 
the top of the File Transfer window.

2 On the SyncTools menu, click SmartXchange. Or click the 
Sync button on the toolbar near the top of the File Transfer 
window.

3 Verify that the source and target are correct. If necessary, 
change the target.

• If you want to include subfolders in the exchange, 
check this box: Include Subfolders.

• If you merely want to update files—and not add new 
ones—check this box: Transfer Only If Files Are 

4 Make sure that this box is cleared: O

5 Click OK.

Updating backup folders
You can also use SmartXchange to s
updating a folder to which you have b

To use SmartXchange to update a 

1 On the left side of the target (back
folder you want to update.

2 On the left side of the source window
taining the files you want to back up 

3 On the SyncTools menu, click Smar

4 Verify that the source and target are 
get if necessary.

• If you want to include subfolder
check this box: Include Subfold

• If you want to update files—and
check this box: Transfer Only If
Target. If you want the folders t
must be cleared.

5 Make sure that this box is checked: O

6 Click OK.
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Replacing one folder with another: Clone Folder

Clone Folder replicates one folder onto another by adding, deleting, and updating files on the
they match those on the source. After opening the target and the source folders, click Clone Fo
SyncTools menu. Then choose whether to include or exclude subfolders.

Clone Folder replaces one folder (the target) with another 
(the source). The effect is the same as deleting everything 
on the target and copying everything from the source.

Cloning a folder adds and updates target files until they are 
identical to those on the source. In addition, it deletes any 
target file that has no counterpart on the source.

NOTE:With Clone Folder, you determ
copied by selecting the folder contain
selecting the items themselves.

Source Target

Use Clone Folder to rep
tents of one folder (the s
the contents of another 

Clone Folder has the ef
ing the target and copyi
source.
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It’s the deletion of files that makes Clone Folder useful, par-
ticularly when you are maintaining a backup folder. With the 

2 On the left side of the source window, click the folder whose 
contents you want to reproduce.

lick Clone Folder on the 

correct. Change the tar-

ithin the selected 
lders.
usual copy operation, the backup folder over time accumu-
lates all the files you have deleted from the source. With 
Clone Folder, those unwanted files are removed with each 
backup.

CAUTION:Use this command with caution. Any subfolder 
or file not on the source will be deleted from the target.

To replace one folder with another:

1 On the left side of the target window, click the folder 
whose contents you want to replace.

3 With the source window still active, c
SyncTools menu.

4 Verify that the source and target are 
get if necessary.

5 If you want to reproduce subfolders w
folder, check this box: Include Subfo

6 Click OK.
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Speeding file transfers with SpeedSync and compressi

When you are updating files, SpeedSync can shorten transfer times by sending only the pa
files that have changed since the last update. SpeedSync is most effective when you update f
have not been changed extensively since the last update. Compression, on the other hand, sp
transfers by “shrinking” files before they are sent and restoring them to their original sizes after
Compression is most effective with large files that have not been compressed already. Thoug
features are in effect by default, there may be circumstances in which you might improve transf
disabling them.

Using SpeedSync
SpeedSync is designed to cut transfer times when you are 
updating files. It has no effect when you are copying files 
that were not on the target before you started copying.

Before a file is copied, SpeedSync searches the target for a 
file with the same name. If none is found, the entire file is 

copied. Otherwise, the two files are c
changes in the source file. Only the c
source file are copied.

The time necessary to locate change
offset by the smaller amount of data t
ferred. The reverse may be true in a f

With SpeedSync
Source and target files are com-
pared to locate changes in the 
source file.

Only the changes are copied, usually 
resulting in faster transfers.

Without SpeedSync
Source and target files are not com-
pared for changes.

Entire files are copied, often resulting 
in longer transfer times.
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particularly when you are updating files over a fast network 
connection.

click SpeedSync Statistics on the SyncTools menu. You 
see the statistics for your most recent transfer as well as 

rs.

 in the transfer of less 
 transfer large files by 
r the savings.

w the transfer of files 
by PKZIP or another 
utomatically turns this 
 files.

ssion does not speed 
 the Options menu, 
rformance tab, clear 
nsferring Files.
NOTE:Whether SpeedSync and compression are used in 
file transfers depends entirely on the settings of the guest 
(the computer that opens the connection).

CAUTION:SpeedSync is a tool for decreasing transfer 
times. It does not merge the contents of two files. The con-
tents of one file will always replace the contents of the 
other. If you need to merge databases, schedules, or other 
shared files, see the documentation for the program in 
which they were created.

To disable SpeedSync:

1 On the Options menu, click File Transfer Options.

2 On the Performance tab, clear this box: Use SpeedSync on 
All File Transfers.

TIP To review the effect of SpeedSync on your past file 
transfers, open at least one File Transfer window. Then 

combined statistics for earlier transfe

Using compression
Because compression usually results
data, it is particularly useful when you
modem: the larger the files, the greate

Since compression would actually slo
that have already been compressed (
file-compression program), LapLink a
feature off while it is transferring such

If you find a situation in which compre
up file transfer, you can disable it: On
click File Transfer Options. On the Pe
this box: Use Compression When Tra



ry lets you 
efore the 

fer:

gent when the inter-
ain.

ransfer windows:

rs.

 a connection while 
g a file, the data 
 at the point of inter-
tored on the target 

 reconnect and 
e transfer, the miss-
 the file—not the 
is copied, along with 
ing files.
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Resuming an interrupted file transfer

If you lose your connection to another computer while transferring files, File Transfer Recove
connect again and continue the transfer where it left off. Any file—or portion of a file—copied b
interruption is skipped; only the untransmitted data is copied.

File Transfer Recovery lets you continue a file transfer even 
when you have lost a connection. Instead of starting the 
transfer at the beginning, File Transfer Recovery resumes 
at the point where the connection was lost:

• Only the missing part of the interrupted file is copied.

• Files successfully copied before the interruption are not 
copied again.

TIP File Transfer Recovery is particularly useful when 
you copy large files over an unreliable modem connection.

To resume an interrupted file trans

• If you were running an Xchange A
ruption occurred, run the agent ag

• If you were transferring from File T

1 Re-establish the connection.

2 Select the same files and folde

3 Begin the transfer again.

If you lose
transferrin
transferred
ruption is s
computer.

When you
resume th
ing part of
entire file—
the remain
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File Transfer Recovery and other options Transfer Only If Files Are Newer  Located on the Filter 
tab, this box must be checked so that files successfully cop-

ied again.

ansfer Recovery cre-
g whatever part of the 
. The file is named 

s a transfer, this file is 
rmine what’s missing. 
SI is given its original 
 Recovery to resume 
er and can be 
Three options must be enabled for File Transfer Recovery 
to work effectively. All three appear in File Transfer Options 
(Options menu) and are enabled by default.

Enable File Transfer Recovery  Located on the Copy/
Move tab, this box must be checked for File Transfer 
Recovery to occur at all.

Use SpeedSync on All File Transfers  Located on the 
Performance tab, this box must be checked to allow the 
transfer to resume with the missing part of a file. When it is 
cleared, the entire file must be sent again.

ied before the interruption are not cop

When a transfer is interrupted, File Tr
ates a file in the target folder containin
file has been transferred successfully
!LAPLINK.TSI.

When File Transfer Recovery resume
compared with the source file to dete
Once the file is complete, !LAPLINK.T
name. (If you do not use File Transfer
the transfer, the file remains in the fold
deleted.)
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Using Xchange Agent—Overview

Xchange Agent automates synchronization—the process of keeping your files updated whe
two computers. To set up an Xchange Agent, open a connection to another computer, choose
of folders to be synchronized; then preview and perform the synchronization. After working on 
either or both of the computers, run the agent to reconnect and update the older copies of the
automatically. You can run an agent by double-clicking its shortcut icon or by scheduling it to r
unattended.

Xchange Agent simplifies the repetitive process of keeping 
two computers—often a laptop and a desktop—in sync. 
Whether your most recent work appears on one or both of 
the computers, Xchange Agent transfers files so that both 
have only the newer copies of your files.

Xchange Agent automates the process of opening connec-
tions, selecting the pairs of folders to be synchronized, set-

ting the appropriate options, initiating 
disconnecting. To prevent unwanted r
view beforehand.

NOTE Xchange Agent is also useful
tions, as when you keep files on you
files on a local network.

Xchange Agent automatically copies the newer versions of all 
files regardless of which computer they are on. Files that have 
no match are copied onto the computer that lacks them.

In the end, files in the synchro
folders are identical.
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Creating an Xchange Agent TIP By default, agents are previewed before being run. 
To bypass preview, click Properties on the File menu and 

b. For more informa-

ange Agent:

e desktop.

ded.

ows Explorer.

s files between fold-
f files. To merge 

e the program in 

 for customizing each 
n:

ead of a two-way 
 direction only, from 

ording to type or 

in synchronized fold-
Open a LapLink connection—by modem, network, or any 
other means—to the computer with which you want to 
exchange files.

Then use the Xchange Agent wizard to create your own 
Xchange Agent:

• From the hierarchy of folders displayed for each com-
puter, choose the pair of folders—one folder on each 
computer—you want to synchronize. Choose as many 
pairs as you want.

• Name your Xchange Agent file and save it.

• Preview the agent you just created, making sure that 
you set it up as intended.

Then run the agent to make the files in each pair of folders 
identical.

NOTE Xchange Agent automatically copies the newer 
versions of all the files regardless of which computer they 
are on. Files that have no match are copied onto the com-
puter that lacks them.

Previewing an Xchange Agent
To prevent unintended consequences, you can preview an 
agent before synchronizing. The preview screen shows 
pairs of folders and files, with arrows to indicate the direction 
in which files will be copied when the agent is run.

In a preview, you can customize the agent by excluding 
pairs of files (and entire folders) from the current synchroni-
zation, leaving the files as they are on each computer.

click an option on the Run Options ta
tion see page 109.

Running an Xchange Agent
There are several ways to run an Xch

• Double-click its shortcut icon on th

• Schedule the agent to run unatten

• Start LapLink and run the agent.

• Double-click the agent file in Wind

CAUTIONXchange Agent exchange
ers. It does not merge the contents o
databases and other shared files, us
which the files were created.

Beyond the basics
Xchange Agent offers various options
synchronization. For example, you ca

• Change the direction of copy: inst
exchange of files, copy files in one
one computer to the other.

• Include or exclude (filter) files acc
name.

• Include or exclude subfolders with
ers.
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Creating an Xchange Agent

Once you connect to another computer, you create an Xchange Agent by selecting the pair
folders—one folder on each computer—which you want to keep synchronized. You can selec
from a window displaying the folders on both computers, or you can drag folders from File Tra
windows onto the Xchange Agent window. In either case, you can preview the agent to ensur
have set up the synchronizations as intended.

To create an Xchange Agent:

1 Start LapLink and open a connection with the computer 
with which you want to synchronize files.

For a local synchronization, simply start LapLink.

2 On the SyncTools menu, click either

• Xchange Agent wizard

• New Xchange Agent
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Using the Xchange Agent wizard Remote, click a folder on each side of the window. 
Repeat the procedure to add other folder pairs.

ndows onto the 
lder first from one 
e other one. Repeat 
pairs.

e synchronized, you 

ew button on the tool-

 the File menu, click 
a name, and click OK.

 each folder pair iden-
oolbar.

the .LLX extension. In 
re stored in the My 
ey are stored in the 
ithin the Windows 
ows NT logon name).
The wizard guides you through the process of selecting 
pairs of folders to be synchronized. After naming and saving 
the agent file, you can preview the agent and change its set-
tings.

To make the files in each folder pair identical, click the Run 
button on the toolbar.

NOTE There are two “modes” in Xchange Agent: edit and 
preview. Certain operations are available in one mode and 
not the other. To save an agent, for example, you must be 
in edit mode. To change to edit mode from preview mode, 
click the Close Preview button on the toolbar.

Using New Xchange Agent
After choosing New Xchange Agent from the SyncTools 
menu, you can select the pairs of folders to be synchronized 
in two ways:

• On the Edit menu, click Add Folder Pair. After specify-
ing whether the synchronization is Local-Local or Local-

• Drag folders from File Transfer wi
Xchange Agent window. Drag a fo
File Transfer window, then from th
the procedure to add other folder 

Once you have selected the pairs to b
can do any of the following:

• Preview the agent: click the Previ
bar.

• Name and save the agent file: On
Save. In the File Name box, type 

• Run the agent to make the files in
tical: click the Run button on the t

TIP Xchange Agent files are given 
Windows 95 and Windows 98, they a
Documents folder. In Windows NT, th
\Profiles\yourname\Personal folder w
folder (where yourname is your Wind
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Previewing and running an Xchange Agent

Previewing an Xchange Agent lets you see exactly which folders will be synchronized and w
will be overwritten. It also lets you skip pairs of folders and files and resolve conflicts. Unless y
otherwise, you preview each agent before you run it. You can run an agent from the Windows
from within LapLink, or you can schedule it to run in your absence.

Previewing
By default, a preview appears whenever you run Xchange 
Agents. You can also open an agent and preview it.

NOTE By default, only agents that you schedule to run 
unattended will proceed without a preview. To set up other 
agents to run without a preview, see page 109.

To open and preview an Xchange Agent:

1 In LapLink, click Open Xchange Agent on the Sync-
Tools menu. (In Xchange Agent, click Open Xchange 

Agent on the File menu.) Then clic
click Open.

2 Click the Preview button on the toolb

While previewing an agent you can d

• Select files or folders to be omit
synchronization only Click a p
Pair button on the toolbar. Skippin
files and subfolders it contains.

While previewing an Xchange Agent, you can 
tell the direction of copy from the arrows.

A special icon appears when both files have been m
previous synchronization. You can specify how these
handled.
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• Put skipped pairs back into a 
synchronization Click a skipped pair and then click 

TIP While in edit mode you can customize an agent in 
several ways. For more information see page 108.

ange Agent:

icon on the desktop. 
en agent, click Cre-
enu.

ppointed time. For 

: Click Run Xchange 
en click the name of 

 Xchange Agent: click 

 the agent file.

 files, the connection 
 LapLink was not run-
matically.

ronizations, refer to the 
ick Logging.
the Undo Skip button on the toolbar.

• Resolve conflicts Click a pair showing a conflict 
icon, click the Resolve Conflict button on the toolbar, 
and specify how you want the conflict resolved. For 
more information about resolving conflicts, see page 
106.

NOTE In a preview, arrows indicate the direction in which 
files will be copied, and thus which files will be overwritten. 
Special icons indicate conflicts between files.

CAUTIONOnce you have resolved conflicts or marked 
pairs to be skipped, run the agent before closing the pre-
view. Your modifications will be lost otherwise.

TIP To select every pair of folders and files in the agent, 
click Select All on the Edit menu.

TIP To locate a pair with a conflict, click the Next Conflict 
button on the toolbar.

To close a preview:

• Click the Close Preview button on the toolbar. You are 
now in edit mode.

Running an Xchange Agent
There are several ways to run an Xch

• Double-click the agent’s shortcut 
To create a shortcut icon for an op
ate Desktop Shortcut on the File m

• Schedule the agent to run at an a
more information see page 112.

• Run the agent from within LapLink
Agent on the SyncTools menu. Th
the agent file and click Open.

• Run an agent you have opened in
the Run button on the toolbar.

• In Windows Explorer, double-click

Once an agent finishes synchronizing
with the remote computer is closed. If
ning to begin with, it is shut down auto

NOTE For a record of your latest synch
LapLink log file: on the Options menu, cl
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When you are keeping folders on two computers in sync, the most common kind of conflict
when a file has been modified on both computers since the last time you synchronized. You c
these conflicts when you preview or run the agent. Or you can set options to handle them auto

Conflicts between files
Conflicts occur when you modify a file on both of your com-
puters. Since both files are new, you need to decide how to 
handle them. These are the choices you can make while 
previewing or running an Xchange Agent:

• Copy either the older or the newer file to the other 
folder, replacing the file already in that folder.

• Copy either the older or the newer file to the other folder 
and give the file a new name. Nothing is replaced.

• Skip the conflict, without copying either file.

When you skip a conflict, you carry it 
nizations. There are now two categor

• New conflicts Files have been 
computers since the previous syn

• Old conflicts Conflicts were lef
synchronizations. The two compu
ent versions of the same file, and b
the latest synchronization. You ca
like new conflicts, or ignore them 
remain.
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Changing how all conflicts are handled  By default, 
each conflict is presented for resolution when you run an 

2 On the File menu, click Properties.

n: Exclude Previously 

flicts in these situa-

r folder with a long 
ept long names.

 a file with a folder; 
 a folder have exactly 

 shorten long names, 
n an agent: copy the 
r skip the conflict with-

rs  If you do not 
ou are given this 
both the file and folder 
ip the conflict without 

 conflicts is to rename 
e the file so that it 

 folder. True synchro-
u set an agent to run 
n a conflict is copied.
Xchange Agent. You can change this so that conflicts are 
handled automatically.

To change how conflicts are handled by an Xchange 
Agent:

1 Open the Xchange Agent.

2 On the File menu, click Properties.

3 On the Run Options tab, click this option: Run Unattended, 
without Preview or Confirmations. Then click either of these 
options:

• Do Not Copy Either; Keep Both Files

• Copy the Newer File over the Older

Ignoring old conflicts  By default, old and new conflicts 
are treated alike, according to the settings on the Run 
Options tab in Properties. For example, if you specify that 
conflicts are to be displayed every time you run an agent, 
old conflicts will appear every time you run the agent. The 
alternative is to exclude old conflicts, regardless of how 
other conflicts are handled.

NOTE To retain both versions of files in old conflicts, click 
this option on the Advanced tab in Properties: Exclude 
Previously Skipped Files.

To exclude old conflicts from synchronizations:

1 Open the Xchange Agent.

3 On the Advanced tab, click this optio
Skipped Files.

Other conflicts
You may encounter other kinds of con
tions:

• When you attempt to copy a file o
name to a drive that does not acc

• When you attempt to synchronize
this happens only when a file and
the same name.

Long name conflicts  If you do not
you are given this choice when you ru
file and give the copy a short name, o
out copying the file.

Conflicts between files and folde
rename the file to avoid the conflict, y
choice when you run an agent: copy 
and give the copies new names, or sk
copying either.

The best way to handle either of these
files: shorten the long names or renam
does not conflict with the name of the
nization cannot occur otherwise. If yo
unattended, for example, neither file i
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 Preview button on 
108

Customizing an Xchange Agent

Instead of a two-way synchronization, you can customize an agent so that files within folder p
copied in one direction only, from one computer to the other. Among other modifications, you ca
shortcut icon to run an agent directly from the desktop, run an agent without a preview, and lim
synchronizations just to the files that already appear on both computers.

To customize an agent, you must open it from within 
LapLink or Xchange Agent.

To open an agent:

• In LapLink, click Open Xchange Agent on the Sync-
Tools menu. Click the agent file and then click Open.

• In Xchange Agent, click Open Xchange Agent on the 
File menu. Click the agent file and then click Open.

Changing the direction of copy
When you create an Xchange Agent,
for a two-way exchange of files. Files
directions, until the folders on both co

You can modify this by specifying that
copied in one direction only, so that o
the other.

NOTE To customize an agent, you m
If you are previewing, click the Close
the toolbar.

To change the direction of the copy, click one 
or more of the folders.

Then click either the left or right arrow button to 
specify the direction.
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To change the direction in which files are copied in a 
folder pair:

• Set up the agent to run unattended: On the File menu, 
click Properties. On the Run Options tab, click this 

review or Confirma-
ts will be handled by 
py the Newer File 

ther; Keep Both Files.

ed in 

irs are included in syn-
o included, but hidden 
ge these settings, 
n click the File 

as necessary.

 set an option to limit 
 files that already 
e files that have been 
ther, check this box: 
t in Both Folders.

termining which files 
r more information, 

 options every time 
 default options to 
 future. These 

s unless you specify 
e defaults, click 
tions menu.
1 Click the folder pair.

To change the direction of copy for all folder pairs, click 
Select All on the Edit menu.

2 Click an arrow button on the toolbar to change the direction 
of the copy.

Adding folder pairs
To add a pair of folders to an Xchange Agent:

1 Open a connection with the computer with which you 
are synchronizing.

2 On the Edit menu, click Add Folder Pair.

3 Click one folder for each computer and then click OK.

NOTE To delete a pair of folders, click the pair and click 
Delete Pair(s) on the Edit menu. Then click Yes. The fold-
ers are deleted from the agent, not from the computers.

Changing how an Xchange Agent is run
There are several ways to customize how an agent is run:

• Create a shortcut icon for running an agent from the 
desktop: on the File menu, click Create Desktop Short-
cut.

• Schedule the agent to run at the time you want: on the 
File menu, click Schedule. For more information see 
page 112.

option: Run Unattended, without P
tions. Then determine how conflic
clicking either of these options: Co
over the Older or Do Not Copy Ei

Changing which files are includ
synchronizations
By default, subfolders within folder pa
chronizations. Read-only files are als
files and system files are not. To chan
click Properties on the File menu. The
Options tab and change the settings 

Also on the File Options tab, you can
synchronizations by exchanging only
appear on both computers. To exclud
added to one computer and not the o
Include Files Only If They Are Presen

NOTE Filters offer another way of de
are included in synchronizations. Fo
see page 110.

TIP Instead of changing the various
you create a new agent, you can set
apply to any agents you create in the
defaults will take effect in new agent
otherwise in Properties. To change th
Properties for New Agents on the Op
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Using preset filters or filters you create yourself, you can limit synchronizations by including o
files or types of files. Or you can use the same filters to exclude files and file types.

Xchange Agent is shipped with filters for some of the most 
common types of files, including Microsoft Word, Lotus 1-2-
3, and dBase. File types are defined by one or more exten-
sions. Word files, for example, are defined by the exten-
sions .DOC and .DOT.

You can also create your own filters for different file types—
or for specific files.

You can use filters to synchronize only the files matching 
the filters. Or you can exclude the files matching the filters 
and synchronize the rest of the files.

To filter files by type using the pres

1 Click a folder pair, and then click S
menu.

To filter all folder pairs, click Select 

2 In the list of available filters, click a filt
Add button. Repeat the process to a

3 To use the filters to exclude—not inc
this box: Exclude Files That Match T

4 Click OK.

Click a
availa
click t

By de
chron
match

If you
filters 
files—
rest.
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To create and apply your own filter: To remove the effects of a filter:

ters.

aring in the list of 
tions, you must add 
n if the filter already 

e filters.

) as necessary and 

filter then click the Add 

k it and then click the 
1 Click a folder pair and then click Set Filter on the Edit 
menu.

2 Under the list of available filters, click the New button.

3 In the Filter Name box, type a description for the filter.

4 In the Pattern(s) box, type one or more file extensions or file 
names, using a semicolon (;) to separate them.

To specify file types, use extensions preceded by aster-
isks: *.chp;*.sty and so on. To specify certain files, 
type their entire names: 
annual.xls;march.xls;april.xls and so on.

5 Click OK.

Your filter now appears in the list of available filters.

6 Click the filter and then click the Add button.

7 To use the filters to exclude—not include—file types, check 
this box: Exclude Files That Match These Filters.

1 Click the filter in the list of active fil

2 Click the Remove button.

Modifying a filter
You can modify any of the filters appe
available filters. To apply the modifica
the filter to the list of active filters, eve
appears in that list.

To edit and apply a filter:

1 Click the filter in the list of availabl

2 Click the Edit button.

3 Change the Filter Name or Pattern(s
then click OK.

4 In the list of available filters, click the 
button.

TIP To delete an available filter, clic
Delete button.
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You can schedule an Xchange Agent to run at a certain time on the days you specify. Schedu
run unattended: there is no preview, and conflicts are handled automatically. To schedule an a
it from within LapLink or Xchange Agent. To run the agent on schedule, simply leave your sch
running.

You can set up an Xchange Agent to run at a particular time 
on one of these schedules:

• Just once, on a particular date (such as June 27, 2000)

• Every day

• On certain days of the week (such
day)

• Once a month on a particular day
of each month)

Yo
X
un

W
tim
st
is
sy
ne
La
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LapLink does not have to be running for an agent to run as 
scheduled. When the scheduled time comes, LapLink 

TIP Once you have scheduled an Xchange Agent in 
LapLink, you should modify it in your scheduler program, 

 the same agent 
ign a different name 

stem and your 

ew, even if you have 
 tab of Properties.

 are ignored; neither 
 newer file in each 
k Properties on the 
lick this option: Run 
irmations. Then click 
 the Older.1

nd synchronizes as 
s Book. Include the 

by the remote com-

onflicts, see page 
starts, the connection is opened, files are synchronized, the 
connection is closed, and LapLink shuts down.

LapLink prepares an Xchange Agent to run on schedule by 
setting it up in a scheduler program running in Windows. If 
you have either of the following scheduler programs, it is 
used to run scheduled Xchange Agents:

• The System Agent program included in the Microsoft 
Plus! Companion for Windows 95

• The Task Scheduler program included in Windows 98 
and Microsoft Internet Explorer 4.0

Otherwise, the LapLink Scheduler program (installed with 
LapLink) is used. The LapLink Scheduler icon appears at 
the right end of the Windows taskbar.

NOTE Xchange Agents can’t be scheduled using the Task 
Scheduler in Windows NT 4.0.

To schedule an Xchange Agent:

1 From within LapLink or Xchange Agent, open the agent.

2 On the File menu, click Schedule.

The Schedule wizard begins.

3 Give a name to the schedule file.

4 Fill out the schedule by specifying the time and frequency.

not in LapLink.

TIP To create another schedule for
repeat the above procedure and ass
to the schedule file.

To run a scheduled agent:

• Leave your Windows operating sy
scheduler running.

Running an agent unattended
A scheduled agent runs without previ
specified preview on the Run Options

When conflicts are encountered, they
file is copied. If you prefer to have the
conflict copied over the older one, clic
File menu. On the Run Options tab, c
Unattended, without Preview or Conf
this option: Copy the Newer File over

TIP To ensure that an agent runs a
scheduled, create an entry in Addres
log-in name and password required 
puter to open the connection.

1 For more information about resolving c
106.
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Using Print Redirection—Overview

There are two ways to print over a LapLink connection. While controlling a remote computer
that computer directly to your local printer. Or reverse direction and print directly from your loca
to a remote printer. Either way, you use Print Redirection to send a document over LapLink to
at the opposite end of the connection. 

Once you have opened a LapLink connection, you can use 
Print Redirection to send a document from the computer at 
either end of the connection to a printer at the other end.

There are two ways to use Print Redirection over a LapLink 
connection:

• Print from remote to local While using Remote Con-
trol to view and operate another computer, you can 
send a document from that computer to a printer at your 
location. For example, you can prepare a document on 
your office computer from home and print the document 
on your home printer.

• Print from local to remote When connected to 
another LapLink computer, you can print a document 
from your computer to a printer at the remote location. 
For example, after working on a report at home or on 
the road, you can connect to your office computer and 
print the report to a high-quality laser printer in your 
office.

Without Print Redirection, you’d have to transfer the doc-
ument to the other computer and then use Remote Con-
trol to run a program on the remote computer and print 
the document.

Printing a document over a LapLink c
printing it on a local printer: In the pro
have prepared the document, choose
command. Normally you would then c
at hand. In Print Redirection, howeve
at the opposite end of the connection

When printing from remote to local, u
choose Print on the remote computer
attached to your local computer.

When printing from local to remote, c
local computer; then choose a printer
puter at the other end of the LapLink 

Preparing for Print Redirection
To print documents from a computer t
end of a LapLink connection, you nee
nation printer on that computer. If you
on the office printer while at home, fo
office printer on your home computer.

1 For detailed instructions on printing ov
nection, see page 118.

2 For detailed instructions on setting up 
Redirection, see page 120.
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You can set up a printer for Print Redirection during LapLink 
Setup or afterward, using Print Redirection options in 

Requirements for Print Redirection
 Print Redirection:

ion of LapLink that 

other computer must 
tion.
LapLink.
There are two requirements for using

• You must connect to another vers
supports Print Redirection.

• The default security setup on the 
be changed to allow Print Redirec



gram and 
ment then 

hoose a local printer 
ote Control. When 
a remote printer from 

t from a Windows 
ram as you normally 
ld, using the Print 
mand.

Then choose the 
printer you set up 
for Print Redirec-
tion.
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Printing over a LapLink connection

To print over a LapLink connection, choose the standard Print command in any Windows pro
then choose a printer set up especially to receive print jobs from remote computers. The docu
travels over the LapLink connection, to a printer at the other end.

Printing over a LapLink connection is much like printing to a 
local printer. You simply choose a different printer—one that 
has been installed especially to print over LapLink.

When printing from remote to local, c
from the remote computer using Rem
printing from local to remote, choose 
the local computer.

Prin
prog
wou
com
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To print a document over a LapLink connection: Choosing among several printers
uments to the printer 

inter on the connected 
 home to the office, for 
e default on the office 
If there is only one 
ter is always used.)

 the default, you need 
a list of available print-
setting on the com-
 the computer with the 

puter, you can still 
lling the computer.

 list of printers:

ttached to, click Print 
s menu.

Printers.

at computer to be 
f all the printers set up 
1 Open a LapLink connection to the remote computer.

• To print from remote to local, include Remote Control 
in the services you open.

• To print from local to remote, open Print Redirection 
or any of the other services.

2 Open a word processor, spreadsheet, or other program and 
prepare the document for printing.

3 Use the standard Print command for your program and 
choose the printer you set up just for Print Redirection. (It is 
typically a printer with [LapLink] at the end of its name.)

The Print Redirection icon on the LapLink status bar ani-
mates as the document is sent over a LapLink connection 
to the destination printer.

When the animation stops, the document has arrived at the 
other computer. You can then close LapLink if you want.

TIP You can monitor the status of the printing document 
after it’s been sent over a LapLink connection. On the 
computer to which the printer is attached, click the Win-
dows Start button, point to Settings, and click Printers. 
Then double-click the printer icon.

NOTE You can use Print Redirection over a LapLink con-
nection even when it is not one of the services currently 
open. Print Redirection becomes available on demand.

Normally, Print Redirection sends doc
that has been set up as the default pr
computer. If you send a print job from
example, the printer designated as th
computer automatically gets the job. (
printer set up on a computer, that prin

If you want to use a printer other than
to set up LapLink to prompt you with 
ers whenever you print. Change this 
puter the printers are attached to, not
document.

TIP If you’re not in front of that com
change this setting by remote contro

To set up LapLink to prompt with a

1 On the computer the printers are a
Redirection Options on the Option

2 Click Prompt with a List of Available 

Whenever you send a document to th
printed, you are prompted with a list o
on that computer.
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Setting up printers for Print Redirection

To print documents from a computer to a printer at the other end of a LapLink connection, yo
set up the destination printer on that computer. If you do not set it up while installing LapLink, yo
up using the Print Redirection Options in LapLink. For best results set up a printer identical to th
will be printing to, at the other end of the connection.

Before you can use Print Redirection, you need to add a 
printer for Print Redirection to the computer you’ll be printing 
from (the location where your documents are kept).

For example, if you’re remote controll
puter and want to print a document on
printer at home, you need to set up yo
office computer.

To set up a new printer, click the Setup button in the Print 
Redirection Options dialog box.

Choose the printer fr

If your printer arrived
click Have Disk.
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If you want to print a document on your home computer to a 
high-quality printer at your office, you need to set up that 

To set up a printer from within LapLink:

edirection Options.

nt Redirection Setup 

int to it, and your docu-
ction. In order to print, 
ted to the computer 
printer on your home computer.

The printer you set up for Print Redirection should match 
the printer you’ll be printing to at the other end of the con-
nection. Although it is possible to use a compatible printer, 
the results you get when printing might not be as good.

Setting up a printer
You can set up a printer during LapLink Setup or from within 
LapLink after installation. You will probably need your Win-
dows CD-ROM or the disk that accompanied your printer.

1 On the Options menu, click Print R

2 Click the Setup button to start the Pri
wizard.

3 Follow the instructions in the wizard.

Once the printer is set up, you can pr
ment is sent over your LapLink conne
LapLink must be running and connec
you want to print to.
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Exchanging typed messages using Text Chat

Text Chat lets you exchange typed messages with a person sitting at a remote computer. Us
service like Remote Control or File Transfer or by itself, Text Chat is useful for exchanging brief 
and sending instructions. However, if you have a microphone, sound card, and speakers, you
Voice Chat instead.

Opening a Text Chat window
When you connected to the remote computer, you may 
have opened a Text Chat window. If not, you can open one 
after you open the connection.

To open a Text Chat window:

• Click the Open Text Chat button on the LinkBar. Or 
click Open Text Chat on the Window menu.

TIP If you have opened more than 
a window for the desired connection
Chat.

Sending messages
A Text Chat window is divided into tw

• The upper part displays the messa
the remote user as well as those 

Read messages se
remote computer—
your own—in the u
the Text Chat windo

Type your messag
part. Press ENTER
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sent to you. Each message is identified by the name of 
the computer from which it was sent.

To paste text into a Text Chat window:

xt editor, select the 

 Text Chat window.

action in the lower 
o on the Edit menu.

t window
t conversation and 

.

n:

indow, highlight part 
versation by clicking 

, and paste the text into 

trol, you can carry on 
st only by viewing the 
en view, you cannot 
 arrange the Text 
trol window, click Tile 
• The lower part serves as a note pad on which you write 
your messages. It clears each time you send a mes-
sage.

NOTE A Text Chat window pops to the foreground on 
your screen whenever the remote user sends a message. 
To keep the Text Chat window from activating automati-
cally, click Text Chat Options on the Options menu. Then 
clear this option: Restore Text Chat Window Automati-
cally.

To send a message to the remote user:

1 Click the Text Chat window.

2 Type your message.

Avoid pressing ENTER until your message is complete. 
To start a new paragraph, press CTRL+ENTER.

3 Press ENTER to send the message.

Pasting text into your Text Chat window
Instead of typing messages while connected, you can pre-
pare them ahead of time and paste them into the Text Chat 
window as necessary.

1 In Notepad or another Windows te
text and copy it.

2 In LapLink, click the lower part of the

3 On the Edit menu, click Paste.

NOTE To reverse your latest editing 
part of a Text Chat window, click Und

Copying text from your Text Cha
You can copy part or all of a Text Cha
paste it into another Windows program

To copy your Text Chat conversatio

1 In the upper part of the Text Chat w
of the text, or select the entire con
Select All on the Edit menu.

2 On the Edit menu, click Copy.

3 Switch to another Windows program
that program.

TIP As a guest during Remote Con
a Text Chat conversation with the ho
host screen in a window. (In full-scre
see your own Text Chat window.) To
Chat window beside the Remote Con
Side by Side on the Window menu.
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Talking to someone using Voice Chat

Voice Chat lets you speak with a person at the other end of a LapLink connection, using the s
that transfers data between the two computers. Both computers must be configured for full du
are to talk as you would on the telephone. If either computer is configured for half duplex, you 
for the other person to stop talking before you begin.

Use Voice Chat to talk to someone you’re connected to 
over LapLink while using other LapLink services like File 
Transfer and Remote Control. To use Voice Chat, you must 
have a computer that is capable of recording and playing 
sound.

You may have started Voice Chat wh
the remote computer. If not, you can s
the connection.

How you talk to the o
in Voice Chat depend
whether the current c
is using half duplex o

You can adjust the v
speaker and microph
them entirely.

When you’re using h
watch the icon to det
to talk and when to li
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Starting Voice Chat Voice Chat conversations are always half duplex unless 
both sound cards are configured for full duplex. The indica-

 shows whether your 
 full duplex.

hod you can use to 
ual mode; see page 

onversation, refer to 
rner of the Voice Chat 
hen the light is green, 
hen the light is red, or 
 wait until the other 

shed talking may help 

ailable on the LapLink 
oice Chat window and 

 full duplex
ed for full duplex 
ver software to your 
anufacturer to find out 
f full duplex, and to 
und card drivers can 
 Web site. 

 person you’re talking 
plex in order for you to 

 may not be able to 
 bandwidth of the con-
To start Voice Chat:

1 Click the Open Voice Chat button on the LinkBar. Or 
click Open Voice Chat on the Window menu.

2 The person on the other end of the connection is “called” 
and asked whether he or she wants to talk with you.

If the Voice Chat connection is accepted, a Voice Chat 
window opens, and you can begin talking to the other 
person.

TIP If you have opened more than one connection, click 
a window for the desired connection before starting Voice 
Chat.

Talking in Voice Chat
To use Voice Chat, you speak into the microphone and lis-
ten through headphones or speakers. If the other person 
can’t hear you very well, increase the microphone level in 
the Voice Chat window. If the other person’s voice is too 
loud or too soft, change the speaker level.

NOTE Although there are other volume/level controls in 
Windows, it is recommended that you use the ones in 
LapLink for best results.

Depending on the configuration of the sound card in both 
computers, you may be able to talk as you would on a tele-
phone; that is, your voice and the voice of the other user 
can be transmitted simultaneously. This is known as full 
duplex.

If you and the other user are not using full duplex, you must 
talk as you would on a walkie-talkie; that is, you must wait 
for the other person to finish before you begin. The trans-
mission of just one voice at a time is known as half duplex.

tor at the top of the Voice Chat window
current conversation is half duplex or

Voice Chat provides an alternate met
talk using Voice Chat, known as Man
130.

Talking using half duplex
When you are having a half- duplex c
the stoplight icon in the lower right co
window to know when you can talk. W
or the text says “Talk,” you can talk; w
the text says “Don’t Talk,” you should
person has finished talking.

TIP Saying “over” when you are fini
facilitate conversation.

Notice that the stoplight icon is also av
status bar, so you can minimize the V
continue talking.

Configuring your sound card for
Some sound cards can be reconfigur
merely by adding new sound card dri
computer. Contact your sound card m
whether your sound card is capable o
obtain sound card driver software. So
often be found on the manufacturer’s

Remember that the sound card of the
to also has to be configured as full du
talk in full duplex.

NOTE Over slower connections, you
use full duplex, because of the lower
nection.
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To improve Voice Chat performance, click the Levels tab in the Voice Chat Options dialog box
configure the microphone and speaker levels and specify information about your environment

If you have already used a program that records and plays 
sound in Windows, you probably do not have to change set-
tings for your speakers and microphone before using Voice 
Chat. (For exceptions, see online help.)

However, Voice Chat lets you change
speaker, microphone, and environme
mance in Voice Chat. It is recommen
once, preferably before you start usin

Use the Levels tab of the
Chat Options dialog box
figure your speaker, micr
and environment levels.

For the speaker and mic
levels, click the button, a
adjust the sliders to the 
level.

For the environment lev
the Setup button and fo
instructions.
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Setting levels in Voice Chat 7 If you could not hear what you recorded, move the Micro-
phone Level slider towards High, and try using the Sound 

he Setup button. The 
nd you’re asked to 
 noise and a few sec-

 avoid transmitting 
mended that you use 

r, to adjust this level.

nection
nection. If you use 
st connection, you 
hat sound quality.

e over a fast con-

Chat Options.

mission Quality to 

when you use a 

onnection, using 
s with your connec-

ur environment level 
ion quality.
The Levels tab on the Voice Chat Options dialog box lets 
you perform recording and playback tests and measure 
other speech qualities. Use the Levels tab when you’re not 
using Voice Chat.

To configure levels in Voice Chat:

1 On the Options menu, click Voice Chat Options.

2 Click the Levels tab.

3 Under Set Speaker Level, click the Play Speech button.

TIP Some sound cards do not allow these settings to be 
changed using software; in this case, the sliders won’t be 
available.

4 While listening to the speech, move the Speaker Level 
slider to a comfortable level.

If you cannot hear the speech, move the slider towards 
High. If the speech is too loud, move the slider towards 
Low.

5 Under Set Microphone Level, click the Record button. The 
Windows Sound Recorder opens. 

TIP If the Sound Recorder is not available, adjust this 
option while you are using Voice Chat, instead.

6 Use the Sound Recorder to record and play back a few sec-
onds of speech. 

Recorder again.

8 Under Set Environment Level, click t
Environment Setup wizard begins, a
record a few seconds of background
onds of speech. 

Setting the environment level helps
sound that is not speech. It is recom
the Setup button, and not the slide

Improving quality over a fast con
Voice Chat works best over a fast con
Voice Chat over a network or other fa
might be able to improve the Voice C

To improve Voice Chat performanc
nection:

1 On the Options menu, click Voice 

2 On the Advanced tab, change Trans
Medium or High. 

Be sure to reset this option to Low 
modem or other slow connection.

CAUTION When you have a slow c
Medium or High may cause problem
tion.

It is recommended that you set up yo
every time you change the transmiss
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Use Voice Chat’s Manual conversation mode if you’re having problems using Voice Chat or
additional control over when speech is sent over the connection. Manual mode requires that y
button in order to talk.

Voice Chat has two conversation modes: Automatic and 
Manual.

• Automatic is the normal conversation mode, and allows 
hands-free operation of Voice Chat. Automatic mode 
sends speech whenever you talk.

• Manual mode requires you to clic
talk.

In most cases, Automatic mode is rec

In Ma
walki
to talk

If you
you c
down
other
using
must
hear 
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Use Manual mode if you’re having problems using Auto-
matic mode, or if your sound card does not support Auto-

Talking in Manual mode
ding on whether your 
lex.

 the walkie-talkie but-
u’re talking, the other 
he sees a “Don’t Talk” 
in to release it. The 

lick the walkie-talkie 
u don’t need to 

n to talk, since in full 
me time.

utton down until you 
alking, since the other 
utton is pressed.
matic mode. If your work environment is very noisy, you 
might have problems using Automatic mode. You can also 
use Manual mode to control exactly when speech is sent to 
the other person. 

To change to Manual conversation mode:

1 On the Options menu, click Voice Chat Options.

2 On the Advanced tab, click Manual Mode.

3 Click OK.

The next time you use Voice Chat, the window includes a 
walkie-talkie button that you use to talk. 

Manual mode works differently depen
conversation is full duplex or half dup

• When using half duplex, you click
ton once in order to talk. While yo
person cannot talk to you (he or s
icon) until you click the button aga
other person can then talk.

• When using full duplex, you also c
button once in order to talk, but yo
release it to allow the other perso
duplex, you can both talk at the sa

Therefore, you can just leave the b
and the other person are finished t
person can talk to you when your b
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Introduction to troubleshooting

This chapter provides checklists for solving problems and 
improving performance. These checklists are designed as a 
quick overview of possible solutions, with enough informa-
tion to guide experienced users to solutions.

For detailed, step-by-step information, consult the trouble-
shooters in online Help. The troubleshooters are designed 
to solve problems you may encounter in opening connec-

tions and using the services once you
nections.

To use an online troubleshooter, open
book in Help Topics and display one o
answer the questions about your prob
gested remedies. In some cases you
tons to dialog boxes; use these button
problem faster.

Use the online troubleshoo
step solutions.

On the Contents tab of Help
the Troubleshooting Book a

T
f
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old or another Win-

e your Windows mo-
enable its port

 good idea to specify 
indows as the modem 
T, there is no alterna-
 LapLink, click Port 
 Modems, and then 

ing the Windows mo-
M port to which the 

r a call

g call unless the Auto 
ptions menu), click 
nd then verify that En-

.

lready in use

 as the modem port is 
r close the program or 

modem

 or dial after you have 
apLink, exit LapLink, 
on. In the Windows 
 click the Diagnostics 
k More Info. If the test 
e the modem. Shut 
Checklist for modem connections 

Allow incoming connections by changing passwords in 
your Log-in List (upgrades only)

Passwords in LapLink Gold are case-sensitive; passwords 
in versions earlier than LapLink 20001 are not. If you have 
upgraded, you may have to change passwords in your Log-
in List:

•  To allow incoming connections from earlier LapLink ver-
sions, retype their passwords in ALL CAPITAL LET-
TERS.

•  To allow incoming connections from other computers 
that have upgraded to LapLink Gold, assign them new 
passwords.

Enable connections to other computers by changing 
passwords in your Address Book (upgrades only)

Passwords in LapLink Gold are case-sensitive; passwords 
in versions earlier than LapLink 2000 are not. If you have up-
graded, you may have to change passwords in your Address 
Book:

•  If your Address Book has entries for computers running 
earlier LapLink versions, retype the passwords in ALL 
CAPITAL LETTERS.

•  If your Address Book has entries for other computers 
that have upgraded, have new passwords assigned on 
those computers and change your Address Book.

Run LapLink on both computers

No connections are possible by modem or any other means 
unless LapLink is running on both computers. You can con-

nect to a computer running LapLink G
dows-based version of LapLink.

In Windows 95 and Windows 98 us
dem for LapLink connections and 

In Windows 95 and Windows 98 it’s a
the modem you’ve already set up in W
to use in LapLink, too. (In Windows N
tive to using the Windows modem.) In
Setup (Options menu), click Windows
check the Enable Port box.

If you have trouble communicating us
dem, use Port Setup to enable the CO
modem is attached.

Ensure that the modem can answe

A modem cannot answer an incomin
Answer option is on. In Port Setup (O
Windows Modems. Click Configure, a
abled under Auto Answer is checked

Make sure the modem port is not a

LapLink cannot use a modem as long
being used by another program. Eithe
wait until it releases the port.

Check the settings for a Windows 

If your modem does not answer calls
enabled it as a Windows modem in L
and make sure the modem is turned 
Control Panel, double-click Modems,
tab, and click the appropriate port. Clic
fails, click the General tab, and remov

1 Versions before LapLink 2000 include LapLink Pro, 
LapLink Tech, and LapLink 7.5 or earlier.
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down the computer and then restart it. Return to Modems in 
the Control Panel and reinstall the modem.

Disable call waiting
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Disable error control and data compression on both 
computers

Some modems communicate better if error control and data 
compression are disabled on both computers. In Port Setup 
(Options menu), click Windows Modems, Configure, and 
then Properties. On the Connection tab, click Advanced. 
Then clear Use Error Control. Repeat this procedure on the 
other computer.

Set a longer timeout value

If the computer you are dialing takes a long time to answer 
and complete the connection, try increasing its modem tim-
eout. In Port Setup (Options menu), click Windows Modems. 
Click Configure and then Properties. On the Connection tab, 
type a larger number in this box: Cancel the Call If Not Con-
nected Within.

Lower the modem speed on the computer opening the 
connection

In Port Setup (Options menu), click Windows Modems. Click 
Configure and then Properties. On the General tab, click a 
lower speed in the Maximum Speed box.

Check the security setup on the remote computer

If you are denied the use of Remote Control or one of the 
other services while connected to another computer, check 
the security setup on that computer. You can gain access to 
services through Security (Options menu).

NOTE To let other computers connect to your computer by 
modem, you must change the security setup established 
during installation.

Ensure that the call waiting feature is 
phone systems at both ends of the co
interferes with modem connections w
detected.

Try using Dialing Properties to sim
cess

When you use a Windows modem, tr
Properties feature in connection with 
plifies the process of accessing outsid
distance and international calls, and u

With the proliferation of area codes, h
that some numbers may not be dialed
make a local call to another area code
within the same area code. In this cas
Book entry for that number so that the
and Area Code box is cleared. In the 
box, type the number exactly as it is to
number for outside access, country co
for long-distance, as required. (When
have to edit this data to reflect your cu

Disable other programs that use C
ning LapLink

You may experience problems if you u
by modem while running any other pr
serial (COM) ports; modem and fax p
itor serial ports for incoming calls or fa
modem to disconnect unexpectedly. D
while using LapLink.
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 Click the Windows 
ications. If Dial-Up Net-
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Checklist for Dial-Up Networking connections

Allow incoming connections by changing passwords in 
your Log-in List (upgrades only)

Passwords in LapLink Gold are case-sensitive; passwords 
in versions earlier than LapLink 20001 are not. If you have 
upgraded, you may have to change passwords in your Log-
in List:

•  To allow incoming connections from earlier LapLink ver-
sions, retype their passwords in ALL CAPITAL LET-
TERS.

•  To allow incoming connections from other computers 
that have upgraded to LapLink Gold, assign them new 
passwords.

Enable connections to other computers by changing 
passwords in your Address Book (upgrades only)

Passwords in LapLink Gold are case-sensitive; passwords 
in versions earlier than LapLink 2000* are not. If you have 
upgraded, you may have to change passwords in your Ad-
dress Book:

•  If your Address Book has entries for computers running 
earlier LapLink versions, retype the passwords in ALL 
CAPITAL LETTERS.

•  If your Address Book has entries for other computers 
that have upgraded, have new passwords assigned on 

those computers and change you
accordingly.

Ensure that Dial-Up Networking is 

You can connect over Dial-Up Netwo
Dial-Up Networking has been installe
should already be installed in Window
or Windows 98, you can install this fe
dows CD-ROM as follows: In the Win
double-click Add/Remove Programs.
Setup tab, and double-click Commun
working is checked, it is installed. If it 
Dial-Up Networking, and then click O

NOTE For more information about M
working, consult Windows Help.

Once connected using Dial-Up Net
the network

When you connect over Dial-Up Netw
dial in to a remote access server and
Then you make LapLink connections
Network dialog box. Unless you speci
available LapLink connections appea
soon as you are connected to the net
nections does not appear automatica
button on the LinkBar and then click N

TIP To connect to another LapLink co
Up Networking connection is establis
this box is checked in the Connect ov

1 Versions before LapLink 2000 include LapLink Pro, 
LapLink Tech, and LapLink 7.5 or earlier.
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Ensure that your computer is set up for network con-
nections

within the same area code. In this case, edit your Address 
Book entry for that number so that the Use Country Code 

Telephone Number 
 be dialed. Include the 
de, area code, and “1” 
 you travel, you may 
rrent location.)
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Making connections to other LapLink computers through 
Dial-Up Networking requires that your computer meet the re-
quirements for network connections in LapLink: a network 
protocol must be installed, your network ports must be en-
abled in LapLink, and so on. For more information about net-
work connections, see page 140.

NOTE To let other computers connect to your computer 
through Dial-Up Networking, you must change the security 
setup established during installation.

Run LapLink on both computers

No connections are possible by Dial-Up Networking or any 
other means unless LapLink is running on both computers. 
You can connect to a computer running LapLink Gold or an-
other Windows-based version of LapLink. Verify that the 
computer has a network port enabled for the same kind of 
network connection as your network port.

Try using Dialing Properties to simplify the dialing pro-
cess

When you use a Windows modem, try using the Dialing 
Properties feature in connection with Address Book. It sim-
plifies the process of accessing outside lines, making long-
distance and international calls, and using a calling card.

With the proliferation of area codes, however, you may find 
that some numbers may not be dialed correctly, as when you 
make a local call to another area code or a long-distance call 

and Area Code box is cleared. In the 
box, type the number exactly as it is to
number for outside access, country co
for long-distance, as required. (When
have to edit this data to reflect your cu

Disable other programs that use se
while running LapLink

You may experience problems if you u
by modem while running any other pr
serial (COM) ports; modem and fax p
itor serial ports for incoming calls or fa
modem to disconnect unexpectedly. D
while using LapLink.

Disconnect a Dial-Up Networking c

When connecting by modem, you ca
break a connection after a specified n
which there is no activity at either end
Click Connect Options (Options menu
tab, check the Disconnect Inactive Co
type the number of minutes below.

In most cases, the connection is comp
specified period. With Dial-Up Networ
however, you must complete the proc
(Connect menu) and then click Disco
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Checklist for LinkToNet connections

Ensure that Dial-Up Networking is installed on the com-
puter you dial from

You can use LinkToNet only if Microsoft Dial-Up Networking 
has been installed. Dial-Up Networking should already be in-
stalled in Windows NT. In Windows 95 or Windows 98, you 
can install this feature from your Windows CD-ROM as fol-
lows: In the Windows Control Panel, double-click Add/Re-
move Programs. Click the Windows Setup tab, and double-
click Communications. If Dial-Up Networking is checked, it is 
installed. If it is not checked, click Dial-Up Networking, and 
then click OK to begin installation.

NOTE For more information about Microsoft Dial-Up Net-
working, consult Windows Help.

The computer you dial in to must be connected to a net-
work, equipped with a modem, and enabled as a 
LinkToNet host

Log the computer on to a network. Then ensure that its mo-
dem is enabled in LapLink: click Port Setup (Options menu), 
click Windows Modems, and then check the Enable Port 
box.

To enable the computer as a LinkToNet host, click LinkTo-
Net Options (Options menu). On the Host tab, check the En-
able LinkToNet box.

Run LapLink on both computers

No connections are possible by LinkT
means unless LapLink is running on b
connection to a computer on the netw
computer has a network port enabled
network connection as your network p

Disable other programs that use se
while running LapLink

You may experience problems if you u
by modem while running any other pr
serial (COM) ports; modem and fax p
itor serial ports for incoming calls or fa
modem to disconnect unexpectedly. D
while using LapLink.

Disconnect a LinkToNet connectio

When connecting by modem, you ca
break a connection after a specified n
which there is no activity at either end
Click Connect Options (Options menu
tab, check the Disconnect Inactive Co
type the number of minutes below.

In most cases, the connection is comp
specified period. With LinkToNet as w
working connections, however, you m
cess: click Disconnect (Connect men
Disconnect All.
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Checklist for network connections

Allow incoming connections by changing passwords in 
your Log-in List (upgrades only)

Passwords in LapLink Gold are case-sensitive; passwords 
in versions earlier than LapLink 20001 are not. If you have 
upgraded, you may have to change passwords in your Log-
in List:

•  To allow incoming connections from earlier LapLink ver-
sions, retype their passwords in ALL CAPITAL LET-
TERS.

•  To allow incoming connections from other computers 
that have upgraded to LapLink Gold, assign them new 
passwords.

Enable connections to other computers by changing 
passwords in your Address Book (upgrades only)

Passwords in LapLink Gold are case-sensitive; passwords 
in versions earlier than LapLink 2000* are not. If you have 
upgraded, you may have to change passwords in your Ad-
dress Book:

•  If your Address Book has entries for computers running 
earlier LapLink versions, retype the passwords in ALL 
CAPITAL LETTERS.

•  If your Address Book has entries for other computers 
that have upgraded, have new passwords assigned on 
those computers and change your Address Book 
accordingly.

Enable the network port for LapLin

Access to a network by e-mail and oth
automatically provide network access
nect by network in LapLink, your netw
abled—that is, made available for use
a network port in LapLink, click Port S
Click the type of network—either IPX 
Ports list. Then check the Enable Por
IPX, click Configure, and ensure that 
Broadcast is checked.

Run LapLink on both computers

No connections are possible by netwo
unless LapLink is running on both com
nect to a computer running LapLink G
dows-based version of LapLink. Verify
a network port enabled for the same k
tion as your network port.

Refresh the list of connections

If LapLink was started on the other co
ed connecting, you may need to refre
connections in order to include the co
the Refresh List button, and wait while
computers is updated.

Ensure that the network is installed

LapLink cannot connect by network u
col—either IPX or TCP/IP—is installe
are installed using the Networks optio
trol Panel. See your Windows Help a
information on adding network protoc

1 Versions before LapLink 2000 include LapLink Pro, 
LapLink Tech, and LapLink 7.5 or earlier.
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Type the TCP/IP name or address address you are trying to reach. Press ENTER. If you do not 
receive a positive reply, the address is not available, and 

ote computer

ontrol or one of the 
ther computer, check 
ou can gain access to 
enu).

of frame on both 

the frame type for the 
elected automatically; 
802.2 or Ethernet 
d on both computers 
rk protocols are in-
e Windows Control 
entation for informa-
If you do not see a computer listed as an available connec-
tion over a TCP/IP network, you may have to type the com-
puter’s IP name or address. Click the Connect button on the 
LinkBar, and then click Network. On the TCP/IP Addresses 
tab, type the IP address or the Windows computer name in 
the TCP/IP Name or Address box. (This name may differ 
from the name assigned to the computer in LapLink.)

TIP To determine the TCP/IP address for a Windows 95 or 
Windows 98 computer, click Port Setup (Options menu); 
click TCP/IP in the Ports list; and then click Configure. The 
computer’s address appears in the IP Address box.

TIP To determine the TCP/IP address for a Windows NT 
computer, click the Start button, point to Programs, and click 
Command Prompt. Then type IPCONFIG and press 
ENTER. The address appears on the IP Address line.

TIP If you cannot connect after typing a TCP/IP address, 
click the Start button, point to Programs, and click MS-DOS 
Prompt. Then type PING followed by a space and the 

you cannot connect.

Check the security setup of the rem

If you are denied the use of Remote C
other services while connected to ano
the security setup on that computer. Y
services through Security (Options m

IPX connections: change the type 
computers

Some IPX connections work better if 
IPX connection is preset rather than s
try setting the frame type to Ethernet 
802.3. This setting should be change
making a LapLink connection. Netwo
stalled using the Networks option in th
Panel. See Windows Help and docum
tion on changing the frame type.
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k the Enable Port box. 
ters.

mote computer

ontrol or any of the oth-
r computer, check the 
an gain access to ser-
).

t to your computer by 
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puters on local TCP/
nfiguration

 connections over the 
the computers is on a 

ut your corporate 
trator.

IP ports: one for the 
ming connection) and 
ening the connection). 
r the Internet, 
 with the Internet As-

s used by the host 
ns through a firewall, 

port 1547.
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Checklist for Internet connections

The computer you want to connect to must have its In-
ternet address published by an Internet directory, and 
you must know what the address is

Connect over Internet is designed for connecting to a com-
puter whose Internet address is “published” by the LapLink 
Internet directory or another ILS Internet directory. To set up 
a computer for this kind of connection, click Internet Directory 
Options (Options menu) and type an e-mail address or other 
unique identifier to be published as the computer’s Internet 
address. Let other LapLink users connect by sharing the ad-
dress with them.

TIP Set up Internet Directory Options to have the address 
published automatically. Or publish the address yourself, 
when you are online: on the Connect menu, click Publish 
My Internet Address.

TIP If you are connecting to a computer whose IP address 
you know, use Dial-Up Networking instead of Connect over 
Network. This kind of connection is usually feasible only 
when you connect to a computer that has a permanent IP 
address.

Both computers must be on the Internet and running 
LapLink

It doesn’t matter how it’s done—by dialing in to an ISP or 
connecting over a direct line—but both computers must be 
connected to the Internet before they can connect using 
Connect over Internet.

And LapLink must be running on both of them.

Enable a TCP/IP port in LapLink

To connect over the Internet in LapLin
port must be enabled—that is, made 
LapLink. To enable a TCP/IP port in L
up (Options menu). Click 
TCP/IP in the Ports list and then chec
Perform this operation on both compu

Check the security setup on the re

If you are denied the use of Remote C
er services while connected to anothe
security setup on that computer. You c
vices through Security (Options menu

NOTE To let other computers connec
Internet, you must change the secur
during installation.

Internet connections between com
IP networks may require special co

Without proper configuration, LapLink
Internet may be prevented if either of 
private or corporate TCP/IP network.

NOTE If you have any questions abo
network, consult the network adminis

LapLink requires the use of two TCP/
host (the computer receiving the inco
another for the guest (the computer op
To facilitate LapLink connections ove
LapLink.com has registered port 1547
signed Numbers Authority. This port i
computer. To allow LapLink connectio
a network administrator should open 
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With most networks, this is the only configuration required. 
With other networks, however, it may be necessary to spec-

To request a specific port on a guest computer, add the fol-
lowing section to the computer’s LLW.INI file (the file is locat-

 Windows folder):

 1025 and 65535, ex-
r example, a number 
f conflicts with other 
ify a port for use by the guest computer. In many cases, the 
TCP/IP stack assigns guest computers the next available 
TCP port number above port 1024, and the firewall automat-
ically allows the connection.

If the firewall does not allow automatic port assignment, how-
ever, LapLink must be configured on the guest computer to 
request a specific port. Consult your network administrator 
before making this change.

ed in the \TSI32\LLW folder within the

[TCPIP]
ClientPort=xxxxx

For xxxxx type any number between
cept 1547. Using a large number—fo
above 30000—reduces the chance o
TCP/IP applications.
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Checklist for cable connections

Ensure that Autoconnect is turned on

Autoconnect opens cable connections for you automatically. 
To ensure that Autoconnect is in effect, click Connect Op-
tions (Options menu). On the Connect tab, verify that this 
box is checked: Enable Autoconnect. Below the option, ver-
ify that the services you want to use are also checked.

TIP If you have trouble maintaining a cable connection, try 
disabling Autoconnect on one or both of the computers.

Run LapLink on both computers

No connections are possible by cable or any other means 
unless LapLink is running on both computers. You can con-
nect to a computer running LapLink Gold or another Win-
dows-based version of LapLink.

Check the cable

Make sure that each end of the cable is securely attached to 
the proper port; check the port labels for proper identification. 
Check a parallel cable for damaged pins. Try reconnecting 
the cable to each port or even reversing the cable ends.

TIP Attach a yellow LapLink cable to parallel/LPT (printer) 
ports. Attach a blue LapLink cable to serial/COM (modem or 
mouse) ports; connect only one end to each computer. 
LapLink does not work over most other serial cables or any 

printer cables. Attach a purple LapLin
port or a USB hub at each computer.

Consult the Windows Device Mana
about USB or other kinds of ports

If you are not certain whether you hav
er kind of port, check the Windows D
click My Computer; then click Properti
Manager tab. Note that USB connectio
Windows NT or in early versions of W

Enable the port

You cannot connect by cable until a p
made available specifically to LapLink
cable connections, click Port Setup (O
the port you want to enable. Then che
box.

TIP If a port is listed as unavailable, q
may be using the port, or enable a dif
that the cable is attached to an availa

Use a serial cable when connecting
Windows 2000 computer

When you want to connect by cable t
LapLink in Windows NT or Windows 
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Use the new LapLink USB Network cable when con-
necting to a Windows 98, Windows 2000, or Windows 

Restart the computer

 both computers, and 
able, and try the con-

ce in Windows 95 

n LapLink for parallel 
e default), the LapLink 
r. The LapLink En-
alternate between par-
 of communications: 
d without experiencing 
 Windows driver, on 
tter performance for 
s driver if you intend to 
If you then want to 
of communication, be 
hand.

om an ECP port, use 
ort to which the cable 

k Port Setup (Options 
LPT port. Ensure that 
 Configure and then 
ndows Driver, Use the 
 LapLink Standard 
Me computer

You must install the USB Network cable driver before you 
connect the cable to your computer. For more information, 
see the instructions for installing the USB Network cable 
driver on the LapLink Gold CD-ROM.

NOTE You can use the older LapLink USB cable when 
connecting to a Windows 95 or Windows 98 computer.

Serial cable connections: lower the speed of a serial 
port

In Port Setup (Options menu), click the COM port to which 
the cable is attached. Click Configure. In the Port Speed box, 
click 57600. Repeat this procedure on the other computer. If 
you still can’t connect, repeat the procedure, lowering the 
speed one step at a time until you can connect.

Serial cable connections: check for an internal modem

In Port Setup (Options menu), look for an internal modem 
that is enabled for the serial port to which the cable is at-
tached. Change the port setup so that the modem is enabled 
for a different serial port.

NOTE Parallel cable connections are not available in Win-
dows NT or Windows 2000; use a serial cable instead.

If all else fails, remove the cable from
restart the computers. Reattach the c
nection again.

Improving parallel cable performan
and Windows 98

There are three drivers you can use i
ports: the LapLink Enhanced driver (th
Standard driver, and a Windows drive
hanced driver is preferable when you 
allel communications and other types
you can leave the parallel port enable
any degradation of performance. The
the other hand, generally provides be
parallel connections; use the Window
use parallel connections exclusively. 
switch to modem or some other type 
sure to disable the parallel port before

NOTE For maximum performance fr
the Windows driver for the parallel p
is attached.

To change the parallel port driver, clic
menu) and then click the appropriate 
the Enable Port box is checked. Click
click one of these options: Use the Wi
LapLink Enhanced Driver, or Use the
Driver.
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Checklist for wireless connections

Make sure you’re not trying to connect to a Windows NT 
or Windows 2000 computer

You cannot connect computers using wireless devices when 
either or both of the computers are running Windows NT or 
Windows 2000. Use a serial cable instead.

Set up the Windows infrared driver

The Windows infrared driver supports a variety of built-in 
ports and devices attached to serial ports. When you set up 
the driver, specify any serial port, from COM1 to COM9, as 
the redirected port. In LapLink Port Setup (Options menu), 
enable the redirected port for wireless communications.

NOTE In LapLink, wireless refers to short-range connec-
tions over infrared or radio devices. Other “wireless” con-
nections are available over wireless LAN adapters (using 
Connect over Network) and cellular modems (using Con-
nect over Modem).

Edit the LapLink initialization file if you use AirShare Ra-
dio Modules

A setting in the LLW.INI file must be changed in order to con-
nect computers using AirShare Radio Modules. Open 
LLW.INI in Notepad; the file is located in the \TSI32\LLW 
subfolder within your Windows folder. Locate the section of 
the file corresponding to your wireless port: [COM1], 
[COM2], and so on. Edit the section so that it includes this 
line: UseIRDADriver=No.

Restart LapLink. In Port Setup (Options menu), ensure that 
the port is enabled for wireless communications.

Enable the wireless port

You cannot connect by wireless until a
for wireless connections in LapLink. I
menu), click the COM port to which th
tached. Click Wireless in the Type bo
Enable Port box.

Ensure that Autoconnect is turned

Autoconnect opens wireless connect
cally. To ensure that Autoconnect is i
Options (Options menu), and verify th
Enable Autoconnect. Below the option
es you want to use are also checked.

Run LapLink on both computers

No connections are possible by wirele
unless LapLink is running on both com
nect to a computer running LapLink G
dows-based version of LapLink.

Check the cable, if any

If you have an external wireless devic
cable is securely attached to the prop

Lower the speed of the ports

If you are using wireless devices with
red driver, try lowering the port speed
In Port Setup (Options menu), click th
the wireless device is attached. Click 
click 57600 in the Port Speed box. Re
the other computer. If you still can’t co
cedure, lowering the speed one step 
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apLink on both com-

 2.0/ISDN or any other 
oth computers. En-

ng on that computer is 

mote computer

ontrol or one of the 
ther computer, check 
ou can gain access to 
enu).

swer calls over CAPI 

l unless the Auto An-
Port Setup (Options 
figure, and then verify 
er is checked.

rica, avoid using the 

ly include CAPI 2.0 but 
apLink. If the device is 
 you can open a 
er Modem or Connect 
ure that the device is 
ns menu) as a Win-
Checklist for CAPI 2.0/ISDN connections

Allow incoming connections by changing passwords in 
your Log-in List (upgrades only)

Passwords in LapLink Gold are case-sensitive; passwords 
in versions earlier than LapLink 20001 are not. If you have 
upgraded, you may have to change passwords in your Log-
in List:

•  To allow incoming connections from earlier LapLink ver-
sions, retype their passwords in ALL CAPITAL LET-
TERS.

•  To allow incoming connections from other computers 
that have upgraded to LapLink Gold, assign them new 
passwords.

Enable connections to other computers by changing 
passwords in your Address Book (upgrades only)

Passwords in LapLink Gold are case-sensitive; passwords 
in versions earlier than LapLink 2000* are not. If you have 
upgraded, you may have to change passwords in your Ad-
dress Book:

•  If your Address Book has entries for computers running 
earlier LapLink versions, retype the passwords in ALL 
CAPITAL LETTERS.

•  If your Address Book has entries for other computers 
that have upgraded, have new passwords assigned on 
those computers and change your Address Book 
accordingly.

Run CAPI-compatible versions of L
puters

No connections are possible by CAPI
means unless LapLink is running on b
sure that the version of LapLink runni
compatible with 
CAPI 2.0/ISDN.

Check the security setup on the re

If you are denied the use of Remote C
other services while connected to ano
the security setup on that computer. Y
services through Security (Options m

Ensure that LapLink is set up to an
2.0/ISDN

CAPI cannot answer an incoming cal
swer option in LapLink is enabled. In 
menu), click CAPI 2.0/ISDN. Click Con
that the Enable box under Auto Answ

If you are using ISDN in North Ame
LapLink CAPI 2.0/ISDN

In North America, ISDN doesn’t usual
you can still use your ISDN device in L
set up as a Windows (TAPI) modem,
LapLink connection using Connect ov
over Dial-Up Networking. Simply ens
enabled in LapLink Port Setup (Optio
dows modem.

1 Versions before LapLink 2000 include LapLink Pro, 
LapLink Tech, and LapLink 7.5 or earlier.
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If your ISDN device is set with its own dialer, use the dialer to 
log on to a network. Then, in LapLink, use Connect over Net-

Close some LapLink services to allow connections over 
both channels

ich channel bonding is 
nections on both chan-
ssible, try closing ser-
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work to connect to other computers running LapLink on that 
network.

Normally CAPI 2.0/ISDN hosts on wh
not enabled can handle incoming con
nels. When only one connection is po
vices on that connection.
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sfer while the comput-
s. (When you attempt 

a computer running 
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w failed.”)
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ntrol Options 
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s Logon Prompt.

transfer speeds:

ave selected for trans-
ncluding more than 
u selected an entire 
nly a few files within 

ansfer times when 
dems: on the Perfor-
Checklist for File Transfer

Drop files directly on target folder

The most common mistake in drag and drop is dropping files 
on the wrong target folder (the folder to receive the files). To 
help prevent this mistake, open the target folder first; the 
name of the folder now appears in the title bar. Then open 
the source folder and select and drag the files until the 
mouse pointer rests on the open folder and the folder is high-
lighted. As soon as you release the mouse button, you re-
ceive a confirmation dialog box showing, among other 
things, the target you just dropped on. Check the target, and 
change it if necessary.

TIP To ensure that files are copied, press CTRL while drag-
ging. To ensure that files are moved, press SHIFT while 
dragging.

TIP If you are copying an entire folder (rather than files 
within a folder), drop the folder on the target one level higher 
than where you want the files to appear; this may be 
another folder or a drive letter. Assume that you want to 
update your Letters folder on your desktop computer with 
your Letters folder from your laptop, and the Letters folder 
appears at the highest level of folders on drive C. Drag the 
folder from the laptop to the desktop and drop it on drive let-
ter C.

Use the Copy or Move command

Instead of using drag and drop, use the Copy or Move com-
mand. First, click the target folder. After selecting the files to 
be transferred, click Copy or Move (File menu). Then verify 
that the source and target are correct.

Make File Transfer available to oth

If you are denied the use of File Trans
services while connected to another c
curity setup on that computer. You ca
vices through Security (Options menu

Log on to Windows before trying t

As a security measure, LapLink does
nect to a computer and open File Tran
er is waiting to be logged on to Window
to open a File Transfer connection to 
LapLink and displaying the Windows 
see this message: “Creation of windo

The solution is to open a Remote Con
Log the remote computer on to Windo
Transfer.

NOTE To set up LapLink to run befo
dialog box appears, click Remote Co
(Options menu). On the Startup tab, 
Always Start LapLink before Window

General tips for faster transfers

Follow these suggestions to improve 

•  Check the folders and files you h
fer, making sure that you are not i
necessary. For example, have yo
folder when you want to transfer o
the folder?

•  Use SpeedSync to improve file tr
updating files, particularly over mo
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mance tab of File Transfer Options, make sure that the 
Use SpeedSync on All File Transfers box is checked.

Maximum Speed list on the General tab, click the maximum 
speed your modem can use.

less traffic on the net-

verify that the network 

two folders so that the 
artXchange always 

ou want to merge the 
ge by opening the two 
ect the individual files. 
ols menu), verify that 
ou do not want to add 
ox: Transfer Only If 

ights to network files 

 copy but then are de-
 them, contact the net-
y files to which you 
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•  Disable any ports that are not in use: in Port Setup 
(Options menu), click an unused port, and then clear the 
Enable Port box.

•  Close other service windows and any connections to 
other computers you may have opened in LapLink.

•  On laptop computers, disable power management 
functions. Attach the AC adapter to the computer to 
ensure steady voltage throughout the transfer.

•  Disable screen savers, and close other programs.

Tips for transfers over a serial cable

•  Ensure that the serial port is configured for maximum 
speed: in Port Setup (Options menu), click the appropri-
ate COM port; click Configure; and ensure that Port 
Speed is set at 115200.

•  Change the transfer mode to standard: in Port Setup 
(Options menu), click the appropriate COM port; click 
Configure; and click Standard under Transfer Mode.

Tips for transfers over modems

Consult the documentation for your modem and verify that 
the port speed is set for optimum performance: In Port Setup 
(Options menu), click Windows Modems. Click Configure, 
and click the modem you are using. Click Properties. In the 

Tips for transfers over a network

TIP Transfer your files when there is 
work.

TIP Ask your system administrator to 
drivers are current.

Tips for SmartXchange

Use SmartXchange to update files in 
folders share the latest files. Since Sm
overwrites older files, do not use it if y
contents of two files. Use SmartXchan
folders you want to update; do not sel
After clicking SmartXchange (SyncTo
you have opened the right folders. If y
new files to either folder, check this b
Files Are Already on Target.

Ensure that you have read access r
you want to copy

If you can locate the files you want to
nied access when you attempt to copy
work administrator. You can copy onl
have been assigned read access.
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ack feature: Click the 

e Log-in List tab, click 
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Checklist for Xchange Agent

Ensure that LapLink is running on the remote computer

LapLink must be running on the remote computer before an 
agent can connect to it and synchronize files. On the local 
computer merely keep Windows running. (LapLink will start 
automatically when the agent runs.)

Make sure that a scheduler program is running

To schedule Xchange Agents—and have them run on 
schedule—you must have a supported scheduler program 
running.

LapLink prepares an Xchange Agent to run on either of 
these scheduler programs: the System Agent program in-
cluded in the Microsoft Plus! Companion for Windows 95; 
and the Task Scheduler program included in Windows 98 
and Microsoft Internet Explorer 4.0 (not supported in Win-
dows NT 4.0). If you don’t have either of these programs, 
LapLink uses its own scheduler program, which it installs 
during Setup. (Its icon appears at the right end of the Win-
dows taskbar.)

NOTE When LapLink Scheduler is running, its icon 
appears on the Windows taskbar.

Change an Xchange Agent schedule in your scheduler 
program

Once you've created an Xchange Agent schedule in 
LapLink, revise or delete the schedule in your scheduler pro-
gram, not in LapLink.

You can disable LapLink Schedule
to use it

If you do not intend to use LapLink Sc
Xchange Agents, you can keep it from
every time you start Windows.

To disable LapLink Scheduler, right-c
button and click Open (in Windows N
ers). Double-click Programs and then
uler and press DELETE.

Close an Xchange Agent before it 

An agent cannot run on schedule wh
Xchange Agent.

Create an Address Book entry to m
quirements of the remote compute

If the remote computer requires a nam
ate an Address Book entry and includ
word required by that computer. LapL
information and connect automatically

Turn off the LapLink callback featu

If the remote computer requires or req
fore opening a modem connection, the
the remote computer, turn off the callb
Security button on the LinkBar. On th
the name of the guest computer and 
Modem Callback, click None.
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Avoid moving or deleting agent files for which you have 
created shortcut icons

TIP Preview the agent to see if the correct files are included 
in the synchronization.

opied in the current 

ecify that certain pairs 
 the current synchro-

and then click the Skip 
 procedure for any oth-
d. Then—before clos-
t—run the agent.

 only from the current 
 a future synchroni-

ot merge, files

ss you specify other-
er computer. It does 

and other shared files, 
re created.
152

If you have moved or deleted the Xchange Agent file, the 
shortcut icon can no longer run the agent. Create the agent 
again. You can reuse the shortcut icon by saving the new file 
in the same location, with the same name, as the original file. 
Or you can create a shortcut icon for the new agent file.

Create a filter to synchronize a single file

Xchange Agent always synchronizes by folder pairs, but you 
can create a filter so that only one file within a folder pair is 
synchronized. Open the agent in Xchange Agent and click 
the folder pair. On the Edit menu, click Set Filter and then 
click New. After typing a description for the filter, type the 
complete name of the file, including its extension. (To add 
more than one file name, type a semicolon and then the next 
file name.) Click OK. Click the filter’s name in the Available 
Filters list, and then click Add.

Use Preview to limit the files to be c
synchronization

While previewing an agent, you can sp
of files and folders will be omitted from
nization: Click a pair of files or folders 
Pair button on the toolbar. Repeat this
er pairs you do not want synchronize
ing Preview or quitting Xchange Agen

TIP You can omit file and folder pairs
synchronization. To remove them from
zation, you must use Preview again.

Use Xchange Agent to overwrite, n

Xchange Agent overwrites files. Unle
wise, it copies the newer file to the oth
not merge files. To merge databases 
use the program in which the files we
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Checklist for Remote Control

Improve performance from the guest

On the guest, you may be able to speed up Remote Control 
connections by changing settings in Remote Control Op-
tions (Options menu) on your computer. On the Perfor-
mance tab, click the Best Performance option. (To further 
customize settings, click the Settings button.) Your view of 
the host should be updated faster, though you will now be 
viewing the host screen in black and white, and larger bit-
maps will not be displayed.

Control the display properties of the host from the guest

By default, LapLink is configured to speed up Remote Con-
trol connections: any wallpaper or screen saver on the host 
is temporarily disabled, along with certain other visual en-
hancements. From the guest, you can restore these en-
hancements to the host screen through settings on your 
computer. On the Performance tab of Remote Control Op-
tions (Options menu), click Best Quality. (To further custom-
ize settings, click the Settings button.) Keep in mind that 
changing these settings may slow Remote Control connec-
tions.

Make Remote Control available to other computers

If you are denied the use of Remote Control or one of the 
other services while connected to another computer, check 
the security setup on that computer. You can gain access to 
services through Security (Options menu).

Use the keyboard to view the host screen

If the window in which you are viewing the host screen does 
not show all of the host screen, you can use your keyboard 

to view areas beyond the borders of t
CTRL+ALT+SHIFT and any of the ar
PAGE DOWN, HOME, or END.

Use the latest driver for your video

Contact the manufacturer of your vide
site or elsewhere, to verify that you are

Avoid changing the color depth or 
a host

From the guest, avoid changing the n
played on the host while you're connec
Control. Also avoid changing the Refr
other settings in the host's Display Pro
ed. To safely change these properties
at the host and fully informed of the ca
Incorrect settings can damage a mon

Use a special key combination to l
NT host

When you restart a Windows NT hos
CTRL+ALT+DELETE to log on to Win
accomplish this from the guest by pre
combination specified on the host. (P
CTRL+ALT+DELETE on the guest af
host.) To specify a key combination fo
start LapLink on the host and click Re
(Options menu). On the Host tab, typ
in this box: Send CTRL+ALT+DELET
When a Guest Presses This Key Com
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TIP Instead of pressing a special key combination for 
CTRL+ALT+DELETE, you can click the Remote Control 

Keep LapLink running before the Windows NT logon 
prompt

t computer to run be-
x appears, avoid clos-
ou have administrator 
ave to restart the com-
 other people can con-
ient.)

 in VGA mode

ning in VGA mode you 
it to other computers 
fer, but the computer 
st. That is, it cannot be 
rs.

s NT host

ograms on a Windows 
LapLink minimizes the 
sage. (To close the 
d click Close.)

indows NT host to dis-
u use a shortcut to a 

 the shortcut icon, click 
 tab. Below Display 
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icon at the bottom of the host’s LapLink workplace, and then 
click Feed CTRL+ALT+DELETE.

Do not install other remote control products and 
LapLink on the same computer

Because of possible incompatibilities, avoid installing 
LapLink and another remote control product on the same 
computer.

Avoid pressing CTRL+ALT+DELETE when viewing a 
Windows NT host in full-screen Remote Control

Pressing CTRL+ALT+DELETE on a Windows NT computer 
always displays the Windows Security dialog box on that 
computer. When you are working in a full-screen Remote 
Control session, pressing CTRL+ALT+DELETE not only 
displays the Security dialog box locally but also causes the 
CTRL and ALT keys to be pressed—but not released—on 
the host computer. To release these keys and resume nor-
mal keyboard operation press CTRL and ALT again.

TIP To have CTRL+ALT+DELETE take effect on a host 
computer, click Send CTRL+ALT+DELETE to Host on the 
guest's Session menu.

If you have set up LapLink on the hos
fore the Windows NT logon dialog bo
ing LapLink on that computer unless y
rights. If you close LapLink, you will h
puter in order to reset LapLink so that
nect. (Restarting LapLink is not suffic

Avoid running a Windows NT host

When a Windows NT computer is run
can make LapLink connections from 
using Remote Control and File Trans
cannot serve as a Remote Control ho
remotely controlled by other compute

Run DOS in a window on a Window

You cannot control full-screen DOS pr
NT host. When you attempt to do so, 
program and displays a warning mes
DOS program, right-click the icon, an

Avoid this problem by setting up the W
play DOS programs in a window. If yo
DOS program, for example, right-click
Properties, and then click the Options
Options, check Window.
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ose among the avail-
ptions (Options menu) 
hed to. Then click 
s.

s, use the default 

rograms (programs 
to Windows 95, Win-
p the destination print-
ter to which it is 
n from the 16-bit Win-

ter instead of selecting 
.

rt Print Redirection

t up a printer to direct 
he usual parallel port. 
oes not allow you to 
 want to contact the 
ted driver is available.
Checklist for Print Redirection

Use the same printer driver on both ends of a connec-
tion

For best print results in Print Redirection, both computers 
should be set up with the same printer driver. To add a print-
er driver, you may need your Windows CD or a disk from the 
printer manufacturer.

Use the Windows Control Panel to get additional infor-
mation

If the document you printed is sent over LapLink correctly but 
does not print, examine the printer in the Windows Control 
Panel to get additional information about why the document 
didn’t print. Make sure the printer is connected correctly and 
has enough paper, and the printer cartridge is not empty.

When several printers are available, you can set up 
LapLink to prompt you for the printer to use

Normally, LapLink automatically directs print jobs to the print-
er currently set up as the default printer at the other end of 
the connection. When there are several printers available, 
however, you may want to use a printer other than the de-
fault.

To set up LapLink to allow you to cho
able printers, click Print Redirection O
on the computer the printers are attac
Prompt with a List of Available Printer

When printing from 16-bit program
printer

Before printing from 16-bit Windows p
written for versions of Windows prior 
dows 98, and Windows NT 4.0), set u
er as the default printer on the compu
attached. When using Print Redirectio
dows program, print to the default prin
a printer from the list of available ones

Some printer drivers do not suppo

To use Print Redirection you must se
print jobs to a special port instead of t
You cannot use a printer driver that d
change the port in this way. You may
printer manufacturer to see if an upda
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nversation, click in the 
lick Select All (Edit 
u). You can then 

uch as Notepad, paste 

ring messages be-

, you can prepare it 
indows program and 

Text Chat. In the other 
 CTRL+C to copy. In 
w, press CTRL+V to 

s

8 characters at once. 
 that exceeds that lim-
smitted to the other 
in parts. Or save the 
ing File Transfer. You 
let the remote user 
s along additional 
156

Checklist for Text Chat

Press ENTER to send your message

Type your message in the lower part of the Text Chat win-
dow. (In some cases, you may have to click in the lower part 
of the window before you can begin typing.) To send your 
message to the remote computer, press ENTER.

TIP To begin a new paragraph, press CTRL+ENTER.

Open a Text Chat window after connecting

If you are connected to more than one computer, be sure to 
specify which computer you want to use Text Chat with: 
Click the name of the computer on the Window menu. Then 
click the Open Text Chat button on the LinkBar or Open Text 
Chat on the Window menu.

Make Text Chat available to other computers

If you are denied the use of Text Chat or one of the other ser-
vices while connected to another computer, check the secu-
rity setup on that computer. You can gain access to services 
through Security (Options menu).

Save your Text Chat conversation from time to time

As a Text Chat conversation grows in length, the most recent 
messages begin to replace the earliest. This starts to hap-
pen when the conversation exceeds 32,000 characters. If 
you intend to save a lengthy conversation, begin saving be-

fore this limit is reached. To save a co
upper part of the Text Chat window. C
menu), and then click Copy (Edit men
switch to another Windows program s
the text, and save it as a file.

Shorten connection time by prepa
forehand

Instead of typing text while connected
ahead of time in Notepad or a similar W
send it to a remote computer through 
application, select the text, and press
the lower part of the Text Chat windo
paste. Then press ENTER to send.

Use File Transfer for long message

Text Chat can send as many as 2,04
When you attempt to send a message
it, part of the message will not be tran
computer. Try sending the message 
message as a file, and send the file us
can still use the Text Chat window to 
know what you’re sending and to pas
notes.
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 the Levels tab (Voice 

es to a comfortable 

s, have a manual con-
. It is recommended 
 a medium level, and 
adphones in LapLink 

sible

m telephones, loud 
 so on. Move your 
rt.

 lot of noise in your 
, you might want to re-
evels tab (Voice Chat 

ormance

oice Chat Options) to 
smission quality to 
n: On the Advanced 
enu) click Low if you 
w connection. Click 
 or other fast connec-
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Use full duplex sound card drivers on both ends of the 
connection

Voice Chat is easiest to use over a full duplex connection; 
you can hear and be heard at the same time, as on the tele-
phone.

For full duplex, both ends of the connection must have sound 
cards with drivers that support full duplex. Contact your 
sound card manufacturer to determine whether your sound 
card supports full duplex; and find out whether drivers are 
available.

When using half duplex, wait for the other person to fin-
ish talking

A common problem in half duplex conversations is knowing 
when to start talking. Use the stoplight icon in LapLink as a 
guideline for when you can talk and when you can’t. In some 
cases, a verbal signal that you are finished speaking (saying 
“over,” for instance) might be helpful, or it might help to sim-
ply pause a few seconds when you are done speaking.

If you’re using Manual mode, be sure to release the walkie-
talkie button; you might not be able to hear the other person 
otherwise.

Adjust your microphone to a comfortable level

Many microphones require adjustment in order to send clear 
speech. Make sure your microphone is placed at a good dis-
tance from your mouth—not too far and not too close—and 

then adjust the microphone level using
Chat Options).

Adjust your speakers or headphon
level

Most speakers, and some headphone
trol that you can use to adjust volume
that you leave the manual controls at
adjust the volume of speakers and he
(or in Windows).

Minimize background noise, if pos

Try moving your microphone away fro
computer power supplies, radios, and
speaker and microphones farther apa

If the person you’re talking to hears a
background or doesn’t hear your voice
set your environment level using the L
Options).

Tips for improving Voice Chat perf

Perform the tests on the Levels tab (V
get the best performance. Adjust tran
match the conditions of the connectio
tab of Voice Chat Options (Options m
are talking over a modem or other slo
High if you are talking over a network
tion.
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e Passwords
ee Passwords
r 36
A
Adapter for CAPI 2.0/ISDN 38
Adding

Address Book entries 22, 32, 38
Log-in List entries 46
Xchange Agent folders 102, 108

Address Book
adding entries to 22, 32, 38
with Remote Control 68
security for 56
using 22, 32, 38
with Xchange Agent 151

AirShare Radio Modules
troubleshooting 146

Allowing guest to reboot 70
Answering calls 40, 135, 147
Arranging

icons 82
Remote Control window 64
Text Chat window 125

Autoconnect
in cable connections 34, 144
in wireless connections 36

Automatic mode in Voice Chat 130
Automating connections 42

B
Bitmaps displayed in Remote Control, customizing
76

Blanking screen
in Remote Control 68
requesting through Address

C
Cable connections

enabling after installation 14
enabling security for 56
opening 34
overview of 34
troubleshooting 144, 145

Call waiting, disabling 136
Callbacks

allowing or requiring 52
and Xchange Agent 151

Calls, answering 40, 135, 147
Canceling selections 85
CAPI 2.0/ISDN connections

adapter for 38
answering calls 40
channel bonding in 41
configuring 41
opening 38
requirements for 38
troubleshooting 147, 148
using Address Book for 38
using in United States 38

Capital letters in passwords. Se
Case sensitivity in passwords. S
Cellular modem, connecting ove
Changing the view 82
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ge Agents 108
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Clearing selections 85
Clipboard information, sharing between computers
74
Cloning folders and files 92
Colors in Remote Control, customizing 76
Compressing files 94
Computer names on network, filtering 31
Connections

automating 42
CAPI 2.0/ISDN 38–41
Dial-Up Networking 20
Internet 24–29
LinkToNet 18
modem 14–17
network 30–33
parallel cable 34
restoring automatically 42
saving 42
serial cable 34
USB Network cable 34
wireless 36

Controlling a host computer 62
Copying

in File Transfer 86
in Remote Control 74
in Text Chat 125

Copying files
already on target 88
existing files only 88
including subfolders 88
newer files only 88
using drag and drop 80, 86

desktop shortcuts for Xchan
Xchange Agents 100–103

CryptoAPI encryption 58
Cutting in Remote Control 74

D
Deleting files permanently 89
Deselecting files 85
Details, viewing file and folder 8
Dialing properties 16, 22, 136
Dial-Up Networking connections

and ISDN 147
LapLink connections, openin
overview of 14
troubleshooting 137, 138

Disabling
automatic connections 35, 3
clipboard sharing 74
keyboard 68
mouse 68

Drag and drop 80, 86
tips 87, 149

Drives
cloning 92
copying 86
denying access to 48
expanding 82
opening 82
selecting 82
viewing contents of 82

Dropping files on target 86
Duplicating folders 92
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E troubleshooting 149, 150
File Transfer Recovery 96

87

 of 84

 31

152

2

Remote Control 76
Enabling
clipboard sharing 74
File Transfer Recovery 96
LinkToNet host 18
modem port 135
network port 140
parallel port 144
rebooting 70
serial port 144
USB port 144
wireless port 36, 146

Encrypting data 58
CryptoAPI encryption 59
LapLink-compatible encryption 59

Existing files only, copying 88
Expanding drives and folders 82

F
Feeding CTRL+ALT+DELETE to the host 70
File names, long 107, 150
File Transfer

copying files 86
drag and drop 80, 86
moving files 86
navigating in window 82
opening 80
optimizing 94
permitting through security setup 46
resuming after an interruption 96
selecting items 80, 84
with SpeedSync 94
tips 149, 150

Files
compressing 94
copying and moving 80, 86–
deleting to Recycle Bin 89
finding 82
merging 94
selecting 80, 84
sorting 82
synchronizing 90, 100–101
updating older copies 88
viewing the number and size

Filtering
computer names on network
files and folders 82
files in Xchange Agent 110, 

Finding folders and files 82
Folders

cloning 92
copying 86
defined 80
denying access to 48
expanding 82
finding 82
moving 86
opening 82
replacing one with another 9
selecting 80, 84
sorting 82
synchronizing 90, 100–101
updating 90

Fonts, changing appearance in 
Full duplex 127, 157
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Full screen mode 64 on host computer 72
Including subfolders in transfers 88

ess connections
rk. See ISDN
6

nections

on 71
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G
Guest computer

blanking host screen from 68
changing appearance of host screen from 76
defined 62
locking host keyboard from 68
locking host mouse from 68
opening Remote Control window on 62
viewing host computer on 64

H
Half duplex 127, 157
Help for troubleshooting 134
Host computer

defined 62
in LinkToNet 18
locking 68
logging on to 70
preparing 70–73
rebooting 70
viewing 64

Host screen
blanking 68
changing appearance of 77
changing guest view of 64, 76
scaling image to fit 65
temporarily lowering resolution of 65
viewing full screen 64

Hosting a Remote Control session 72

I
Icons

arranging 82

Infrared connections. See Wirel
Integrated System Digital Netwo
Internet addresses, publishing 2
Internet connections

enabling host for 26
encrypting data over 58
opening 24–25, 28–29
overview of 24
troubleshooting 142, 143

Internet directories 24–28
Introduction to LapLink 6–10
IP name or address 30, 141
ISDN

connecting over 38–41
troubleshooting 147, 148
See also CAPI 2.0/ISDN con

Items, selecting 80, 84

K
Keyboard

control, customizing 66
disabling on host 68

Keys, system and shortcut 66

L
LapLink

overview 6–10
starting before Windows log

LapLink Internet directory 24–28
!LAPLINK.TSI file 97
LapLink-compatible encryption 
Levels in Voice Chat 128
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Linking clipboards 74
LinkToNet connections

tips 150
troubleshooting 135–136

6

ows 82

puters 31

nections

Sync 94

7
 33, 47
23, 33, 47
enabling host for 18
opening 18
overview of 14, 18
troubleshooting 139

.LLC extension 43
LLW.INI file 146
.LLX extension 103
Local security password 56
Locking host computer 68
Lockout 50
Log-in List

adding entries to 46
enforcing 46

Log-in name 46
Long file names 107, 150
Lowercase letters in passwords. See Passwords

M
Manual mode in Voice Chat 130
Merging files 90, 94
Messages in Text Chat 124
Microphone, configuring for Voice Chat 128
Minimizing guest computer 72
Minus signs in folder icons 82
Modem connections

Address Book entries for 22
dialing from Address Book entries 16
dialing manually 17, 23
Dial-Up Networking connections 14
LapLink-to-LapLink connections 14, 16
opening 16
overview of 14

types of 14
Mouse

disabling on host 68
using in drag and drop 80, 8

Moving files. See Copying files

N
Navigating in File Transfer wind
Network connections

filtering list of available com
and ISDN 147
opening 30
overview of 30
troubleshooting 140, 141
See also CAPI 2.0/ISDN con

O
One-way file exchange 90
Opening

File Transfer 80
Remote Control 62
Text Chat 124
Voice Chat 126
Xchange Agents 104

Optimizing transfers with Speed
Overview of LapLink 6–10

P
Passwords

case-sensitivity 17, 23, 33, 4
from earlier versions 17, 23,
entering to gain access 17, 
for incoming connections 46



 Index

protecting against crackers 50
for security system 56

configuring host for 70
after guest disconnects 70

g 74
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r 46
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tips 51
troubleshooting 135, 137, 140, 147

Pasting
in Remote Control 74
in Text Chat 124

Plus signs in folder icons 82
Ports

CAPI 2.0/ISDN 147
enabling 135, 140, 144, 146
modem 135
network 140
parallel 144
serial 144
speed, changing 145
USB 144
wireless 146

Previewing an Xchange Agent 100, 152
Print Redirection

opening 118
overview of 116
requirements for 117
setting up printers for 120
troubleshooting 155

Privileges, granting to remote users 46
Protected system 46
Protecting

drives and folders 48
security options 56

Publishing Internet addresses 26

R
Rebooting host in Remote Control 70

Recycle Bin, deleting to 89
Remote access servers 14
Remote Control

bitmaps displayed in 77
clipboard information, sharin
colors displayed in 77
controlling the host 62
fonts displayed in 76
improving performance of 76
locking the host computer 6
logging on to Windows NT d
minimized window on host 7
opening 62
overview of 62
permitting through security s
rebooting host computer 70
requesting through Address
reversing 72
serving as a host 72
shortcut keys, changing 66
troubleshooting 153, 154
using Print Redirection in 11
using Windows system keys
viewing the host computer 6

Replacing folders 92
Resolution of host screen, chan
Restarting host in Remote Cont
Restoring

connections 43
Text Chat automatically 124

Restricting access to a compute
Resuming an interrupted file tra
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Reversing Remote Control 72
Running Xchange Agents 105

Sharing clipboards 74
Shortcut icon

ith 105, 152
l 66

e Chat 127

87
hat 129

96
S
Saving connections 42
Scaling Remote Control windows 66
Scheduling Xchange Agents 112
Screen blanking 68
Screen saver, allowing to run on host screen 77
Security

for drives 48
encrypting data 58
for folders 48
locking out password crackers 50
Log-in List, adding entries 46
password for the security system 56
password protection, setting up 46, 56
See also Passwords

Selected files, viewing the number and size of 84
Selecting files and folders 80, 84

clearing selections 85
Selecting text in Text Chat window 125
Sending CTRL+ALT+DELETE to the host 70
Serial ports

enabling 144
speed, changing 145

Services
allowing 46
File Transfer 80
Print Redirection 116
Remote Control 62
Text Chat 124
Voice Chat 126

Setting filters in Xchange Agent 110, 152

creating 42, 108
opening connections with 42
running an Xchange Agent w

Shortcut keys in Remote Contro
SmartXchange

tips 150
using 90

Sorting files and folders 82
Sound card, configuring for Voic
Source

in drag and drop 80, 86
using menu commands 86–

Speaker, configuring for Voice C
SpeedSync 94

and File Transfer Recovery 
reviewing effect of 94

Starting
File Transfer 80
LapLink before Windows 71
Remote Control 62
Text Chat 124
Voice Chat 126
Xchange Agents 104

Statistics for SpeedSync 94
Subfolders

defined 80
including in transfers 88
navigating through 82

Synchronizing folders 90
System keys 66
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TCP/IP connections 140, 141

DN in 38
 over 34

 files 84
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Talking using Voice Chat 127
Target

in drag and drop 80, 86
using menu commands 86

TCP/IP connections
IP name or address, finding 30
IP name or address, specifying 30
opening 30
troubleshooting 140, 141

Text Chat
copying text in 125
opening 124
overview of 124
pasting text in 124
permitting through security setup 46
selecting text in 125
sending messages over 124
troubleshooting 156

Tiling windows 125
Transferring files. See Copying files
Transmission Quality, improving 129
Troubleshooting

cable connections 144, 145
CAPI 2.0/ISDN connections 147, 148
Dial-Up Networking connections 137, 138
File Transfer 149, 150
Internet connections 142, 143
ISDN connections 147, 148
LinkToNet connections 139
modem connections 135–136
network connections 140, 141
Print Redirection 155

Text Chat 156
USB connections 144
using online Help for 134
Voice Chat 157
wireless connections 146
Xchange Agent 151, 152

Two-way file exchange 90

U
United States, using CAPI 2.0/IS
USB Network cable, connecting
USB ports

enabling 144
verifying in Windows 144

V
Viewing

files and folders 82
host computers 64
number and size of selected

Voice Chat
Automatic mode 130
over a fast connection 129
full duplex 127
half duplex 127
improving quality of 129, 15
Manual mode 130
opening 126
overview of 126
performance of 128
starting 126
talking over 127
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troubleshooting 157
using 126

107, 108, 109, 110, 111, 112, 113
adding folder pairs to an agent 102, 108

me 110

e 110

1, 104, 151

d 112, 151
W
Wallpaper, showing on host screen 77
Window

File Transfer 80
Remote Control 62
Text Chat 124

Windows NT, logging on to during Remote Control
71
Windows system keys 66
Wireless connections

devices supported 36
enabling after installation 146
enabling security for 56
opening 36
overview of 36
troubleshooting 146

Wireless LAN adapter, connecting over 36

X
Xchange Agent 100, 101, 102, 103, 104, 105, 106,

closing preview 104
conflicts defined 106
copying in one direction 108
creating an agent 100–103
disabling callbacks for 151
excluding files by type or na
filtering files 110
including files by type or nam
overview 100
previewing an agent 100–10
resolving conflicts 104–107
running an agent 105
running unattended 112
running without preview 112
scheduling to run unattende
skipping folder pairs 104
troubleshooting 151, 152

Xchange Agent wizard 102
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